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Qualified Persons
 WARNING

Only qualified persons knowledgeable in the installation, operation, and 
maintenance of overhead and underground electric distribution equipment, along 
with all associated hazards, may install, operate, and maintain the equipment 
covered by this publication . A qualified person is someone trained and competent 
in:

• The skills and techniques necessary to distinguish exposed live parts from nonlive 
parts of electrical equipment

• The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualified person will be exposed

• The proper use of special precautionary techniques, personal protective  
equipment, insulated and shielding materials, and insulated tools for working on 
or near exposed energized parts of electrical equipment

These instructions are intended only for such qualified persons . They are not 
intended to be a substitute for adequate training and experience in safety  
procedures for this type of equipment .

Read this Instruction 
Sheet

NOTICE
Read this instruction sheet thoroughly and carefully before installing or  
operating the IntelliNode Interface Module . Become Familiar with the Safety 
Information on page 4 and Safety Precautions on page 5 . The latest version 
of this publication is available online in PDF format at sandc.com/en/support/
product-literature/ .

Retain this Instruction 
Sheet

This instruction sheet is a permanent part of the IntelliNode Interface Module. Designate 
a location where users can easily retrieve and refer to this publication.

  WARNING
The equipment in this publication must be selected for a specific application . The 
application must be within the ratings furnished for the selected equipment . Refer 
to S&C Specification Bulletin 1043-31 .

Proper Application
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The standard warranty contained in S&C’s standard conditions of sale, as set forth in 
Price Sheets 150 and 181, applies to the IntelliNode Interface Module, except the first 
paragraph of the said warranty is replaced by the following:

(1) General: The seller warrants to the immediate purchaser or end user for a period of  
10 years from the date of shipment that the equipment delivered will be of the 
kind and quality specified in the contract description and will be free of defects of 
workmanship and material. Should any failure to conform to this warranty appear 
under proper and normal use within 10 years after the date of shipment, the seller 
agrees, upon prompt notification thereof and confirmation that the equipment has 
been stored, installed, operated, inspected, and maintained in accordance with 
the recommendations of the seller and standard industry practice, to correct the 
nonconformity either by repairing any damaged or defective parts of the equipment 
or (at the seller’s option) by shipment of necessary replacement parts. The seller’s 
warranty does not apply to any equipment that has been disassembled, repaired, 
or altered by anyone other than the seller. This limited warranty is granted only 
to the immediate purchaser or, if the equipment is purchased by a third party for 
installation in third-party equipment, the end user of the equipment. The seller’s 
duty to perform under any warranty may be delayed, at the seller’s sole option, until 
the seller has been paid in full for all goods purchased by the immediate purchaser. 
No such delay shall extend the warranty period.

Replacement parts provided by the seller or repairs performed by the seller 
under the warranty for the original equipment will be covered by the above special 
warranty provision for its duration. Replacement parts purchased separately will 
be covered by the above special warranty provision.

For equipment/services packages, the seller warrants for a period of one year 
after commissioning that the IntelliNode Interface Module will provide automatic 
fault isolation and system reconfiguration per agreed-upon service levels. The  
remedy shall be additional system analysis and reconfiguration of the IntelliTeam® 
SG Automatic Restoration System until the desired result is achieved.

Warranty of the IntelliNode Interface Module is contingent upon the installa-
tion, configuration, and use of the control or software in accordance with S&C’s 
applicable instruction sheets.

This warranty does not apply to major components not of S&C manufacture, 
such as batteries and communication devices. However, S&C will assign to imme-
diate purchaser or end user all manufacturer’s warranties that apply to such major 
components.

Warranty of equipment/services packages is contingent upon receipt of  
adequate information on the user’s distribution system, sufficiently detailed 
to prepare a technical analysis. The seller is not liable if an act of nature or  
parties beyond S&C’s control negatively impact performance of equipment/ 
services packages; for example, new construction that impedes radio commu-
nication, or changes to the distribution system that impact protection systems,  
available fault currents, or system-loading characteristics.

Special Warranty 
Provisions
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Several types of safety-alert messages may appear throughout this instruction sheet and 
on labels attached to the IntelliNode Interface Module. Become familiar with these types 
of messages and the importance of these various signal words:

 DANGER
“DANGER” identifies the most serious and immediate hazards that will result 
in serious personal injury or death if instructions, including recommended  
precautions, are not followed .

  WARNING
“WARNING” identifies hazards or unsafe practices that can result in serious  
personal injury or death if instructions, including recommended precautions, are 
not followed .

  CAUTION
“CAUTION” identifies hazards or unsafe practices that can result in minor  
personal injury if instructions, including recommended precautions, are not followed .

NOTICE
“NOTICE” identifies important procedures or requirements that can result in product 
or property damage if instructions are not followed .

If any portion of this instruction sheet is not understood and assistance is required, 
contact the nearest S&C Sales Office or S&C Authorized Distributor. Their  
telephone numbers are listed on S&C’s website sandc.com, or call S&C Global Support 
and Monitoring Center at (888) 762-1100.

NOTICE

Read this instruction sheet thoroughly and carefully 
before installing or operating an IntelliNode Interface 
Module .

If additional copies of this instruction sheet are needed, contact the nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be replaced 
immediately. Replacement labels are available by contacting your nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

Understanding Safety-
Alert Messages

Following Safety 
Instructions

Replacement 
Instructions and 
Labels
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 DANGER

IntelliNode Interface Modules operate devices at high voltage. Failure to 
observe the precautions below will result in serious personal injury or death.

Some of these precautions may differ from your company’s operating procedures 
and rules . Where a discrepancy exists, follow your company’s operating procedures 
and rules .

1 . QUALIFIED PERSONS. Access to an IntelliNode 
Interface Module must be restricted only to qualified 
persons . See the “Qualified Persons” section on  
page 2 .

2 . SAFETY PROCEDURES. Always follow safe operating 
procedures and rules . Always maintain proper 
clearance from energized components .

3 . PERSONAL PROTECTIVE EQUIPMENT. Always use 
suitable protective equipment, such as rubber gloves,  
rubber mats, hard hats, safety glasses, and flash  
clothing, in accordance with safe operating procedures 
and rules .

4 . SAFETY LABELS. Do not remove or obscure any of  
the “DANGER,” “WARNING,” “CAUTION,” or “NOTICE” 
labels .

5 . MAINTAINING PROPER CLEARANCE. Always  
maintain proper clearance from energized components .
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These instructions were prepared for use with IntelliNode Software installer versions 
ITNInstaller-7.6.x and later. References in this manual to the IntelliTeam SG Automatic 
Restoration System apply for IntelliTeam SG software revision 7.6.x, as indicated in 
Instruction Sheet 1044-570, “IntelliTeam® Designer: User’s Guide.”

The revision number is on the Setup>General>Revisions screen. For questions 
regarding the applicability of information in this chapter to previous software releases 
or future versions later than 7.6.x, contact S&C Electric Company.

     WARNING
These instructions do NOT replace the need for utility operation standards . Any  
conflict between the information in this document and utility practices should be 
reviewed by appropriate utility personnel and a decision made as to the correct  
procedures to follow .

The IntelliNode Interface Module is connected to switchgear operating at 
primary voltage levels . High voltage may be present in the wiring to the switch 
control or the switch control itself during certain failures of the switchgear wiring 
or grounding system or because of a failure of the switch itself . For this reason, 
access to the switch control should be treated with the same safety precautions 
that would be applied when accessing other high-voltage lines and equipment .  
Follow all locally approved safety procedures when working on or around this 
switch control .

Before attempting to access an existing switch installation, check carefully for  
visible or audible signs of electrical or physical malfunction (do this before  
touching or operating the switch control or any other part of the installation) . These  
warning signs include such things as smoke, fire, open fuses, crackling noises, 
loud buzzing, etc . If a malfunction is suspected, treat all components of the  
installation, including the switch control and associated mounting hardware, as 
though they were elevated to primary (high) voltage .

Whenever manually reconfiguring the circuit (for example, during repairs), follow 
your company’s operating procedures to disable automatic operation of the 
IntelliTeam SG Automatic Restoration System . This prevents any unexpected  
operation of a team member . 

The IntelliTeam SG Automatic Restoration System can be disabled by selecting the  
Prohibit Restoration state for any member of a team .

Applicable Software
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The IntelliTeam SG Automatic Restoration System lets teams of controls work together 
to isolate faults and restore service. Whether a team consists of a few switches on a 
single feeder or a complex configuration with multiple alternate sources, S&C recom-
mends mapping out the team(s) and gathering all necessary information before installing 
hardware in the field. S&C also recommends keeping a copy of this information in the 
door of the switch control enclosure or low voltage cabinet.

During planning and setup of fault-detection settings, be sure to consider the fault 
conditions the IntelliTeam SG system may encounter from alternate sources. Follow 
these steps to implement the IntelliTeam SG system:

STEP  1.  Create a layout of the source(s), IntelliRupter fault interrupters, switches, 
reclosers, and line segments that comprise teams in ItelliTeam Designer. See 
Instruction Sheet 1044-570: “IntelliTeam® Designer: User’s Guide.”

Use a system map or similar diagram showing source and switch locations.

STEP  2.  Plan the communications system.

For more information, see the manufacturer’s documentation for the 
communications system, or contact your local S&C representative regarding 
available communications related services.

STEP  3.  Identify and name the teams.

For m teams of l ine segments bounded by Intel l iRupter fau lt  
interrupters, switches, and reclosers. Choose a team name up to 16  
characters. IntelliTeam Designer will automatically assign team designations 
to each team in the Team Number field. If configuring the team members to 
operate in the IntelliTeam II Compatibility Mode setting, assigning team  
designations on the Setup>Restoration>IntelliTeam SG>Team x screen is 
required. The Team 1 through Team 8 tabs are analogous to Team 1 through 
Team 8 assigned by IntelliTeam Designer. If choosing to manually determine 
the team designations, teams that share a team member must have different 
designations.

STEP  4.  Assign each team member a DNP/RTU address.

Each team member requires a unique DNP/RTU address. Enter this infor-
mation on the Device Attributes tab found in IntelliTeam Designer or in the 
Setup>Restoration>IntelliTeam SG>Team Summary screen when configuring 
the IntelliNode module for the IntelliTeam II Compatibility Mode setting.

STEP  5.  Determine the IntelliRupter fault interrupter, switch, or recloser position 
number for each team member.

Each team member is associated with a specific switch/position number 
(for example, Sw1 for a single overhead switch). Enter this information in 
the Sw/Pos Number setting on the Setup>Restoration>IntelliTeam SG> 
Team x>Team Member Settings screen.

STEP  6.  Note the normally Open/Closed state for each team member.

I f  c o n f i g u r i n g  t h e  I n t e l l i No d e  I n t e r f a c e  Mo d u le  fo r  t h e  
IntelliTeam II Compatibility Mode setting, enter this information in the  
Normal Open/Close setting on the Setup>Restoration>IntelliTeam SG> 
Team x>Team Member Settings screen. Otherwise, set the normally open 
points in the IntelliTeam Designer diagram.

Planning the 
IntelliTeam SG System
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STEP  7.  Determine the normal functionality for each team member.

IntelliTeam Designer automatically assigns the normal function for each 
device in the system diagram when the Validate command is used. If con-
figuring the IntelliNode Interface Module to operate in the IntelliTeam II 
Compatibility Mode setting, determine the normal function and enter it in the  
Normal Sw Func setting on the Setup>Restoration>IntelliTeam SG>Team 
x>Team Member Settings screen. Each team member must be assigned one of the  
following normal functions:

Functionality Description

Closed Switches

Source/Sub Use this value when the source switch is the first team member 
after the substation/source or it’s an IntelliNode Interface 
Module on the source breaker relay. 

Source Use this value for one closed switch in the team through 
which the line segment receives power when the circuit is in 
its normal configuration.

Load/Tie A team may have zero, one, or multiple closed switches 
through which loads on other line segments receive power. 
Use this value when the switch could be involved in restoring 
power to the line segment because line segments on the other 
side of the switch have alternate sources. 

Load A team may have zero, one, or multiple closed switches 
through which loads on other line segments receive power. 
Use this value when the switch could not be involved in restor-
ing power to the line segment because line segments on the 
other side of the switch have no alternate sources. 

Every closed switch should have its sensors facing the 
normal source of the team.

Open Switches

Tie/Sub Use this value when the tie switch is the first team member 
after the substation/source.

A Tie/Sub switch should have its voltage sensors facing the 
alternate source.

Tie Use this value for zero, one, or multiple open switches in the 
team that restore power to the line segment directly from an 
alternate source when closed.

Enter this information on the Setup>Restoration>IntelliTeam SG>Team x screen. A 
team may have eight members. One Source or Source/Sub and from zero to seven in any 
combination of the other functional types.
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STEP  8.  Determine the Return to Normal mode for each team.

If desired, the team members can return the circuit to its normal configu-
ration automatically when stable three-phase voltage has been restored to a 
faulted line segment.

For teams with one or more tie IntelliRupter fault interrupters, switches, or 
reclosers, select the Open Transition option, in which case the tie device(es) 
open before other team members return the circuit to its normal configuration. 
Or select the Closed Transition option, in which case team members close 
the normal source IntelliRupter fault interrupters, switches, and reclosers and 
then the tie device(es) open. The Return to Normal process starts at the line 
segment closest to the normal source and works outward.

Select this information with the Rtn to Norm Mode setting on the 
Setup> Restoration>IntelliTeam SG>Team x>Team Member Settings screen 
when configuring the IntelliNode Interface Module for the IntelliTeam II  
Compatibility Mode setting.

STEP  9.  Determine the value for the Return to Normal Time setpoint.

Power must be restored to a faulted line segment for this amount of time 
(in minutes) before the Return to Normal process will start. Enter this  
information on the Team Member Attributes tab found in IntelliTeam 
Designer or on the Setup>Restoration>IntelliTeam SG>Team x screen.

STEP  10.  Determine the Maximum Capacity for each team member.

This is the maximum load (in amperes) of the line section limited the most 
by conductor size, device rating, etc., when the team is served through that 
line section from either direction. Each team member continuously subtracts 
its present load from its Maximum Capacity setting to determine its Local 
Capacity for Transfer value. The smallest Local Capacity for Transfer 
value encountered in a particular restoration path determines the maximum 
load that the involved teams can transfer—the Available Capacity to  
Transfer value.

Enter this information in the Maximum Capacity setpoint on the 
Team Member Attributes tab found in IntelliTeam Designer or on the 
Setup>Restoration>IntelliTeam SG>Team x>Team Member Settings screen.

STEP  11.  Determine the alternate source sequence for each team.

Using the Normal Switch Function setting discussed in Step 7 on  
page 8, set the sequence that team members will use to restore the line 
segment. If the team cannot use the source device to restore the line segment, 
it will use an alternate team member. Enter this information in the Alternate 
Source Sequence setpoints on the Team Member Attributes tab found in 
IntelliTeam Designer or on the Setup>Restoration>IntelliTeam SG>Team x 
screen.
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STEP  12.  Determine whether a contract is required to avoid overloading a line segment.

If there is concern a line segment may overload, set the Contract 
Required setpoint to “Yes” on the Team Member Attributes tab found in  
IntelliTeam Designer or on the Setup>Restoration>IntelliTeam SG>Team x 
screen. 

If a circuit is bifurcated, multiple events can result in an overload if contracts 
are not used. To avoid overloading on bifurcated circuits, set this value to 
“Yes.” When team members encounter a line segment in a restoration path that 
requires a contract, they will communicate with all subsequent line segments 
in the direction of the alternate source to ensure that the alternate source will 
not be overloaded. This will slow down the reconfiguration process.

STEP  13.  Determine whether the number of line segments restored by a team must be 
limited.

If the number of line segments a team picks up must be limited, enable the 
Line Segment Limit setpoint on the Team Member Attributes tab found in  
IntelliTeam Designer or on the Setup>Restoration>IntelliTeam SG> 
Team x screen. For example, the Add 1 selection inhibits additional line 
segments from being restored through a member after it restores its first line 
segment.

To allow the team to pick up as many line segments as capacity allows, set 
it to “N/A.”

STEP  14.  Determine the appropriate Prohibit Restoration timer setting for each team.

The default setting is zero, which allows the IntelliTeam SG system to look 
for a restoration solution indefinitely. See the “IntelliTeam System Planning” 
section in S&C Instruction Sheet 1044-570: “IntelliTeam® Designer: User’s 
Guide,” for more information.

STEP  15.  If Post Restoration Load Management is allowed, determine the Load  
Priority setting for each team.

See the “IntelliTeam System Planning” section in S&C Instruction Sheet 
1044-570: “IntelliTeam® Designer: User’s Guide,” for more information.
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The following steps explain how to start IntelliLink Setup Software when working with 
the setpoints or stored data in a switch control. To edit a snapshot (virtual memory file) 
or view the software without data, see the “Using Snapshots” section in S&C Instruction 
Sheet 1043-541, “IntelliNode Interface Module: Operation.”

NOTICE
Always use a grounded (three-wire) extension cord or battery power . When using 
an ungrounded (two-wire) extension cord to power either the computer or the switch 
control while they are connected, the serial port on the computer may be damaged . 

STEP  1.  Connect the computer to the switch control. Use the Local Communication 
Access port on the faceplate and a serial cable.

STEP  2.  Double click on the IntelliLink icon in the S&C Electric folder, and the 
S&C Electric IntelliShell—Select Connection Mode dialog box opens.

STEP  3.  Click on the Local Connection (Serial or Wi-Fi) button, and the S&C Electric 
IntelliShell—Product Selection dialog box opens.

STEP  4.  Click on the IntelliNode Interface Module tab.

STEP  5.  Click on the Serial button at the bottom of the dialog box and the S&C Electric 
IntelliShell—Local Communication Setup dialog box opens.

STEP  6.  Click on the IntelliLink button in the upper right corner. The S&C IntelliLink 
software program will start and the S&C IntelliLink—Registered Log In dialog 
box opens.

STEP  7.  Enter the username and password, and the IntelliLink Setup Software will 
open the Operation screen. See Figure 1 on page 17. Contact S&C Electric 
Company when the default username and password are needed.

NOTICE
With software later than version 7 .3 .100, the default passwords for all user accounts, 
including the Admin account, must be changed before the IntelliLink software can 
connect to and configure a control . See the “Security” section on page 92 for 
more information .

Starting IntelliLink 
Software
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Figure 1. The Operation screen for the IntelliNode Interface Module.

The Operation screen shows the present status of various switch control settings, any 
existing fault, and error conditions. See Figure 1.

To display the Operation screen: Click on the “Operation” entry in the left-hand  
navigation tree.

Operation Screen

Note: When IntelliLink software does not establish communication with a functioning 
IntelliNode Interface Module, it displays the message: “Could not set connection” in the 
dialog box. See Figure 2 on page 13.
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Figure 2. The IntelliLink Connect dialog box.

If this message appears or if the Operation screen opens but the software does not 
operate properly, see S&C Instruction Sheet 1043-551, “IntelliNode™ Interface Module: 
Troubleshooting.”

The IntelliLink User Interface includes many standard features found in Windows-based 
products as well as some custom features designed to make navigating through the  
IntelliNode Interface Module settings easier. See Figure 3.

IntelliLink Software 
Workspace

Figure 3. IntelliLink software features.

Tool bar
Status bar

Navigation tools
Sub-screen selection tabs

Navigation tree
Screen area

Communication status
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Tool Bar

Open Snapshot
Same as Main Menu>File>Open Snapshot— 
Clicking this icon opens a file browser to allow the 
selection of a snap snapshot file.

Save Data  
Snapshot

Same as Main Menu>File>Save Data Snapshot— 
Clicking this icon allows you save a snapshot of the 
control data. It provides a picture of the controls 
memory content is a programing format.

Save Setpoints
Same as Main Menu>File>Save Setpoints—
Clicking this icon opens the Save Setpoints dialog 
box.

Load Setpoints 
Same as Main Menu>File>Load Setpoints—
Clicking this icon opens the Load Setpoints dialog 
box.

Zoom In
Clicking this icon increased the size of objects and 
text in the screen area.

Zoom Out
Clicking this icon decreased the size of objects and 
text in the screen area.

Validate
Same as the Validate button on the Setup>Validate/
Apply screen. See Figure 46 on page 100. Checks 
the pending changes but does not apply them.

Apply

Same as the Apply button on the Setup>Validate/
Apply screen. See Figure 46 on page 100. Checks 
the pending changes and applies them if no errors 
are found.

Reset

Same as the Reset Buffer button on the Setup> 
Validate/Apply screen. See Figure 46 on page 100. 
Removes pending changes and returns to settings 
in the memory.

 When setpoints from an earlier or later compatible version of IntelliLink software is loaded and the setpoints 
do not exist in this version, an error will occur because the software does not understand any setpoints not 
presently supported by the software . The unknown objects also will not be converted .
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Navigation Tree

Expand Arrow

This arrow indicates item to the right is 
collapsed with additional items under-
neath. Clicking this icon expands the list 
to show the hidden sub-items.

Collapse Arrow

This arrow indicates item to the right 
is expanded showing additional items 
underneath. Clicking this icon collapses 
the list to hide the displayed sub-items.

Status Bar

Connected to:
This field shows the user-defined device 
name. The device name is entered on the 
Setup>General>Site-Related screen.

Location:
This field shows the user-defined device 
location. The device location is entered on 
the Setup>General>Site-Related screen.

Validate Status
This f ield shows the status of the  
Validate and Apply functions.

Navigation Tools

Navigation  
History

Clicking this icon opens a list of the last 
10 screens visited. Selecting a screen 
from the list will automatically transition 
from the present screen to the selected 
screen. 

Navigate Back
Clicking this icon selects the next screen 
down in the history list.

Navigate  
Forward

Clicking this icon selects the next screen 
up in the history list.

Breadcrumb 
Field

This field contains the path of the current 
screen.
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Screen Area and Data Entry

The screen area contains various data objects used for configuring the control as well 
as some features for displaying and accessing the data objects. The basic data objects 
contain text boxes for direct text entry and list boxes for data selection.

Editable Text 
Boxes

Text boxes with white background and 
light blue text indicate editable content. 
The cursor will change when hovering 
over and editable field.

Non-editable 
Text Boxes

Text boxes with a grey background and 
dark blue text indicate dynamic text that 
is populated by the control. This text  
cannot be changed.

List Boxes

List boxes as indicated by the down 
arrow supply a list of choices when 
selected. The current selection will either 
be shown on the list box or in an adjacent 
text box.

Check Boxes

Check boxes will be provided for enable/
disable decisions. Data fields for disabled 
items will be automatically hidden or grey 
shaded. Data fields for disabled items  
cannot be changed.

Text Expanders

Expanders are provided to help manage 
the view. When the data below the 
expander are visible, the expander 
icon arrow points up. Clicking the icon  
collapses or hides the data from view. 
When the data are hidden, the expander 
arrow points down. Clicking the icon  
displays the hidden date.

Sub-screen Selection Tabs

Active Tab Green indicates an active screen tab.

Inactive Tab

Grey indicates an inactive tab. Clicking 
on an inactive tab changes from the 
active screen to the screen associated 
with the tab.
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Communication Status

The communication status bar at the bottom of the IntelliLink screen displays the 
connection addresses, the Refresh mode, and the last refresh. The time changing 
after “Refresh:” indicates the control is communicating. The refresh defaults to Auto 
mode but can be stopped by clicking on the Stop button and manually refreshed by 
clicking on the Once button that comes into context when the refresh is stopped. 
See Figure 4.

Figure 4. The communication status bar.
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When the IntelliNode Interface Module is set up for team and normal operation, 
carry out the series of steps outlined in the “Suggested Team Setup Procedure” 
flow charts at the end of S&C Instruction Sheet 1043-501, “IntelliNode™ Interface  
Module: Product Description.”

The values to be entered on each setup screen depend on the electrical distribution  
system and details specific to each individual switch.

     WARNING
These instructions do not replace the need for utility operation standards . Any 
conflict between the information in this document and utility practices should be 
reviewed by appropriate utility personnel and a decision made as to the correct 
procedures to follow .

Establish communication with the IntelliNode Interface Module and start the  
IntelliLink software.

Figure 5. The Setup>General>Site-Related screen.

Device Location
Enter the location of the IntelliNode module, up to 64 characters. See Figure 5. The  
location is displayed on every screen at the bottom.

GPS Coordinates
Location data from the Integrated Global Positioning System are automatically displayed. 
This is only valid for a GPS-equipped IntelliNode module.

Device Serial Number
The serial number is automatically read from the control memory.

IntelliNode Interface 
Module Configuration

Site-Related
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Log

Logging Level
The selected logging level determines the type of data-log messages captured in compact 
flash and displayed on the Logs>Historic Log screen. Every data-log message is assigned 
to one of these log levels:

Normal: User information

Extended: User information and internal status

All: User information, internal status, and internal trace/debugging information

Duplicate Event Margin (ms)
Storing duplicate events that occur rapidly can flood the internal memory, and duplicate 
events are not useful diagnostic information. Every element of the event records must 
match for events to be considered duplicate. This setpoint selects duplicate data that 
will be stored in the internal memory and displayed on the Logs>Historic Log screen. It 
determines the time between logging duplicate events. It has no effect on an alternating 
sequence of events.

For example, the setpoint can be set to 10 ms. For a sequence of events ABABAB 
(where A and B are different), assume the next event occurs 1 ms after the previous one. 
Even when identical events occur within 2 ms—well within the value of the set point—all 
events will be logged. (Minimum value: 0; maximum value: 30; increment: 1)

Stop Historic Logging if Full
When enabled, this option stops event logging when the historic event log is full; subse-
quent events are discarded without overwriting the existing log contents. Flash Memory 
logging, Status Point logging, and Special Event Counter logging are not affected by this 
setpoint. Only set it to the Enabled state when troubleshooting. When troubleshooting is 
complete, or new event data are desired, set this option to the Disabled state to return 
to Continuous Event logging.

Compact Flash Logging
When enabled, every historic event generated is written to flash memory. The Logging 
Level and Duplicate Event Margin setpoints do not prevent an event from being written 
to flash memory, so flash-memory logging preserves as much data as possible. Flash-
memory data are retrieved through IntelliLink Setup Software. Open the Tools item on 
the menu bar and click on the Compact Flash Access entry. Select and save any files 
needed. It is strongly recommended that the Compact Flash Logging mode be enabled 
on the Logs>Log Management screen to simplify diagnostic and troubleshooting work.
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Figure 6. The Setup>General>Time screen.

Time Source Synchronization
Select from the drop-down list: GPS (default), SCADA, GPS and SCADA, or User Set 
mode. SCADA can only function for Master 1.

When SCADA mode is selected, the real-time clock will be synchronized to the time 
and date specified in the SCADA master’s time synchronization request. Configuration 
of the Time Sync Request Interval setting is required.

When GPS and SCADA mode is selected, the GPS signal will be used when  
available. If the GPS signal is not available, the real-time clock will be synchronized to the 
time and date specified in the SCADA master’s time synchronization request; otherwise 
the master’s time synchronization request is ignored. Configuration of the Time Sync 
Request Interval setting is required.

When User Set mode is selected, the real-time clock will synchronize once to the 
time indicated on a user-furnished computer or the time entered by the user. Go to the 
Tools menu, select the “Device Maintenance” entry from the drop-down list, and click 
on either the Set Control Time button to enter the user-set time or the Synchronize 
with PC button.

The clock synchronization source and daylight savings time are configured on the Time 
screen. See Figure 6.

Time
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Time Sync Request Interval (if Time Source=SCADA or Time Source=GPS and 
SCADA)
When this interval (in minutes) expires the control will assert IIN1.4 (Need Time) on 
every response until the master successfully writes absolute time and date using Object 
50 variation 1. (Minimum: 1; Maximum: 10080; Step: 1, Default: Disabled)

Real-Time Clock
This is the date and 24-hour time display.

Active Time Source
This display indicates the time source as the real-time clock or as the GPS source.

Control Time Zone
Select from the drop-down list. GMT (UTC = 0) is the default.

All time-stamped files and the internal time are Universal Time, Coordinated (UTC), 
also known as Greenwich Mean Time (GMT). Local time also can be displayed by using 
the Control Time Zone and Daylight Savings Time settings.

Daylight Savings Time
Select from the drop-down list: No (default) or Yes mode.

Note: Select the Start Day, End Day, and Offset settings for the Daylight Savings 
Time feature.

GPS  

Number of Satellites Tracked by GPS
This is the number of satellites used in the calculation of the position and time displays. 
Triangulation of three satellites at a minimum is required to determine position, but 
three satellites in a straight line cannot determine position. Only one satellite is required 
to determine time.

GPS Fix Quality
This statement indicates the GPS fix quality:

• Invalid

• GPS fix (SPS)

• DGPS fix

• PPS fix

• Real Time Kinematic

• Float RTK

• Estimated (dead reckoning)

• Manual input mode

• Simulation mode
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Horizontal Dilution of Precision of GPS Fix
This statement indicates the relative estimate of GPS horizontal position fix accuracy:

<1 = Ideal—This is the highest confidence level.

1-2 = Excellent—The position measurements are accurate for most applications.

2-5 = Good—This is the minimum information appropriate for making business 
decisions.

5-10 = Moderate—This information could be used for calculation, but a more open sky 
view is recommended.

10-20 = Fair—This indicates a low confidence level, producing a very rough estimate of 
the present location.

>20 = Poor—This information can be inaccurate by as much as 300 meters with a 
6-meter accurate device.

Signal Stability Countdown
This counter starts when a signal returns after it had been lost. It counts down from 
300 seconds. If the timer reaches 0 (the signal has persisted for 300 seconds), the signal 
is considered stable.

GPS Status
This statement indicates the status of time, position, and reception conditions:

• Time and Position OK

• Time and Pos OK, Pending Stability

• Time and Pos OK, No Pulse Signal Time and Position Invalid

• Data Invalid: Serial-Line Anomaly

• Data Invalid: Serial-Line Error

• Data Invalid: Serial-Line Silence

• Disabled By User

• Not Initialized

GPS Signal Available
A “Yes” display indicates the GPS signal is adequate to permit GPS time synchronization.

Satellite Signal Noise Ratio
This displays the satellites in view by ID number and the signal-to-noise ratio in dB for 
each satellite. The number of satellites in the list can be higher than the number shown in 
the Number of Satellites Tracked by GPS field. 30 dB+ is a good signal, 20 dB to 30dB 
is an acceptable signal, 10 dB to 20 dB is a poor signal, and less than 10 dB is unreliable.
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Figure 7. The Setup>General>Software Versions screen.

Data for the installed version update whenever a new software revision is installed. The 
expected value is stored in the IntelliLink software, and the installed version is loaded 
from the connected control. See Figure 7.

The latest control software revisions are available at the S&C Automation Customer 
Support Portal, which requires an assigned username and password. Register for portal 
access at this link: sandc.com/en/support/sc-customer-portal/.

Figure 8. The Setup>General>User Notes screen.

Any character used in a standard text file can be entered. Field capacity is 1000 char-
acters. See Figure 8.

Software Versions

User Notes
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Figure 9. The Setup>External Device>Start screen.

As a configuration check, when the Device Data Updates mode is in the  
Running state, any change to automatic operation, status points, analog input points, or 
control points will set it to the Stopped state. This prevents any unintended operation 
while the external device configuration is being changed. The normal configuration 
sequence is to be in the Stopped state, complete all configuration changes, and then 
set the Running state.

NOTICE
Before making changes to any DNP settings on the Setup>Communications 
screens, set the Device Data Updates mode to the Stopped state to prevent data 
from being used incorrectly . When the changes are completed, set the Device 
Data Updates mode to the Running state to allow use of the retrieved data .

Device Data Updates
When set to the Running state, the IntelliNode Interface Module polls the external device 
for status points, analog input points, and counter points. A check is also made to verify 
any programmed automatic settings have associated status points, control points, and 
analog input points programmed. If not, the Running state will change to the Stopped 
state, and a Protection Configuration Error state will be active in the Status Point 
log. For example, when the Extended Voltage Loss and Single Phase Voltage Loss 
feature is enabled on the Setup>External Device>Auto Operation screen, status points 
for voltage present and analog input points for phase voltage must be entered. See Figure 9.

External Device Setup

24  S&C Instruction Sheet 1043-531

IntelliNode Interface Module Setup



Verbose External Device Polling Log
When this is set to the Enabled state and the Device Data Updates mode is set to the 
Running state, the Logs>Historic Log screen will capture the transmission and response 
of the communication data to the external device (with time stamps). This is useful 
for fine-tuning the communications link to the device. However, the frequently logged 
messages will fill up the compact flash unnecessarily, so setting this to the Disabled 
state will stop the frequent messages from being logged.

Voltage Trip mode can be initiated by the external device or IntelliNode Interface 
Module. This is true for extended three-phase and single-phase voltage losses. 
If the IntelliNode module Voltage Trip mode is enabled, one or both features 
must be selected, and the time and threshold must be set. If the user chooses to 
initiate voltage tripping using the external device, the Extended Voltage and 
Single Phase Loss Protection mode is set to “None,” and the time and threshold  
settings become N/A. Then, the time and threshold must be specified in the external 
device. If the user chooses to configure the IntelliNode Interface Module to initiate voltage 
trips and also leave voltage tripping active in the external device, then the external device 
time threshold should be shorter than the IntelliNode module Loss-of-Voltage Time 
Threshold setting to give the external device logic priority.

When the external device initiates a single-phase or three-phase voltage trip, the  
IntelliNode Interface Module will see the action as an external operation. However, this 
action will be qualified as a valid transfer event when it is accompanied by a voltage loss 
event. The IntelliNode Interface Module will look at the Voltage Present status points 
to make this decision.

When the IntelliNode Interface Module initiates a single-phase or three-phase voltage 
loss event, the module will use the Voltage analog points to make a sectionalizing 
decision.

If the user selects Single-Phase, Three-Phase, or Both Types for the Extended 
Loss Protection setpoint, logic checks the analog inputs and binary status points to 
make sure voltage status and analog input voltage points have been programmed/mapped 
to support an extended voltage-loss operation. If they have not been mapped, alarm 
processing will prevent the team from going into the Ready state.

The Setup>External Device>Auto Operation screen permits enabling or disabling  
various automatic switch control operations and entering the setpoints for these  
operations. See Figure 10 on page 26.

Automatic Operation
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Interface Module

Extended VLoss and Single Phase VLoss
Enable this setpoint to have the IntelliNode control initiate Extended Single-Phase or 
Three-Phase Voltage Loss conditions. Options are the Enabled or Disabled (default) 
settings.

Extended VLoss and Single Phase VLoss Protection Type
Enter the desired protection type. Setting options are Three-Phase Voltage Loss 
(default) and Extended Single-Phase and Three-Phase Voltage Loss.

Extended VLoss and Single Phase VLoss Time (sec)
Enter the amount of time in seconds to qualify a voltage or phase loss. (Minimum value: 
1; maximum value: 255; default value: 45; increment: 1)

Extended VLoss and Single Phase VLoss Threshold
To qualify a voltage or phase loss, the reported analog values are converted to a 120-Vac 
base and then compared to this value. (Minimum value: 1 Vac; maximum value: 255 Vac; 
default value: 90 Vac; increment: 1 Vac)

Figure 10. The Setup>External Device>Auto Operation screen.
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Recloser Blocked Time (sec) 
When a Close operation is executed, the IntelliTeam SG system does not register a suc-
cessful close until the timer elapses. Only then is the reconfiguration process allowed to 
continue. (Minimum value: 1; maximum value: 20; default value: 5; increment: 1)

The Control Point Operation Timeout setting, located on the Setup>External 
Device>DNP Control Point Map screen, is an overall timer the IntelliTeam SG system 
uses to not wait indefinitely for control point operations to complete. To allow time for 
the external device to qualify a good close operation, make sure the Recloser Blocked 
Time setting is always less than the Control Point Operation Timeout setting.

Memory Reset Time (sec)
This is the number of seconds during which the IntelliTeam SG system remembers that a 
voltage loss or overcurrent event occurred and can use this information if the event leads 
to a lockout condition of this relay/recloser device or any source-side device. Generally, 
set this value to a time 5 seconds longer than the Maximum Lockout Time setpoint. 
(Minimum value: 0; maximum value: 65,535; default value: 45; increment: 1)

Manual Operation Timeout (sec)
Whenever the normally closed external device is reporting the Open state, this timer is 
started to wait for the cause of the change of state. A Manual Operation Alarm condi-
tion is not entered when:

• A Frequency Trip state is indicated, the IntelliNode module has initiated an Extended 
Voltage Loss Trip command, Fault Targets are active, and the Cycling state is not 
in the configuration (The Cycling state becomes active when fault targets are active 
and the Tripped to Lockout state is active.)

• The manual operation timeout occurs before any of the above indicators become 
active and a Manual Operation Alarm condition is entered

• On a normally open external device, if the IntelliTeam SG system isn’t involved with 
a restoration Close command and a closed indication is reported (At this time, the 
Manual Operation timer is not used and an immediate Manual Operation Alarm 
state is entered.)

• The IntelliNode module senses the external device has tripped open with voltage-
loss indicators (This is qualified as a Manual Operation state.) (Minimum value: 1; 
maximum value: 255; default value: 5; increment: 1)

Coordinate Fault Events with Recloser Cycle Status
To enhance the coordination with external recloser devices, this setpoint is used instead 
of the Memory Reset Time setpoint for how long the IntelliTeam system remembers 
an overcurrent event. The benefit is, while the Reclose Cycle status point is active, the 
IntelliTeam system will not attempt to clear voltage loss or overcurrent events. If the 
setpoint is disabled, the Memory Reset Time setpoint is used as before. Options are 
the Enabled or Disabled (default) settings.

S&C Instruction Sheet 1043-531  27

IntelliNode Interface Module Setup



Maximum Load Break Current
Before the IntelliTeam system issues the Open command for restoration activity, the 
real-time load current for each phase is compared with the Max. Load Break setpoint, 
and if the phase current on all phases is below the setpoint, the Open command can 
resume. If the current remains above the setpoint for 10 seconds, the IntelliTeam system 
will stop asking the switch to open. Restoration will still be attempted on other switches 
in the team. (Minimum value: 50 A; maximum value: 65,535 A; default value: 600 A; incre-
ment: 1 A)

System Frequency
Select the system frequency, either the 60 Hz or 50 Hz option. (Default: 60 Hz) This 
setting is required when using the IntelliTeam SG system across different voltage classes.

System Phase-to-Phase Voltage
Enter the value of the system phase-to-phase voltage in kV. (Range: 4.00-40.00;  
Step: 0.01 kV; Default: 12.47 kV) This setting is required when using the IntelliTeam SG 
system across different voltage classes.

Current Direction Detection Method
The IntelliTeam system uses this setting to accurately calculate loading for each team 
and capacity for each feeder.

When the None option is selected, the IntelliTeam system will not take directionality 
into consideration for this device when calculating loading. It assumes current is flowing 
in the Normal direction. The current direction status on the Operation screen displays 
“No Dir.” (Default: None)

When the Status Points option is selected, the device uses the status of the Normal 
Current Flow and/or Reverse Current Flow DNP status points to determine current 
direction. If both the Normal and Reverse Current Flow status points are configured 
and both points are either active or inactive at the same time, the IntelliTeam system 
assumes current is flowing in the normal direction. The current direction status on the 
Operation screen displays “No Dir.”

When the Current Polarity option is selected, the device uses the polarity of analog 
current values to determine current direction.

• If the polarity of the Phase ABC Current DNP analog points is positive, the device 
determines current is flowing in the normal direction.

• If the polarity of the Phase ABC Current DNP analog points is negative, the device 
determines current is flowing in the reverse direction.

• If the Phase ABC Current DNP analog points report mixed polarity values, the 
device will sum the phases together to determine current direction. When the sum 
of all phases is greater than or equal to 0, current is flowing in the normal direction. 
When the sum of all phases is less than 0, current is flowing in the reverse direction.
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Positive Current Direction
When the Current Polarity setpoint is used for the current direction detection method, 
the Positive Current Direction setpoint is then used by the IntelliTeam system to 
determine the normal positive polarity current flow direction of the external device. 
Set this setpoint to the Sensor-side to Non-sensor side mode, which is the default, if 
normal current is flowing from the sensor side of the external device to the non-sensor 
side. Otherwise, set this setting to the Non-sensor side to sensor-side mode if normal 
current is flowing from the non-sensor side of the external device to the sensor side.

External Device Settings 
These settings direct the IntelliNode module in its operation of the host relay/recloser 
device. Options are the Supported or Unsupported settings. When enabled, the 
Supported setting has Enabled and Disabled options.

Reclosing 
When this parameter is set to Supported and Enabled settings, it indicates to the  
IntelliNode module the Reclosing feature of the host device is enabled in its normal 
state and the Reclosing feature is available for use by the IntelliTeam SG system during 
reconfiguration events. The sequence of commands sent to the host device when this 
parameter is supported and enabled are: 1), block reclosing, 2), send the Close command, 
and 3), re-enable reclosing.

When reclosing is unsupported, the IntelliTeam SG system will not issue the Reclosing 
Block and Reclosing Enable commands during reconfiguration. When reclosing is sup-
ported and enabled and the IntelliNode module detects the reclosing feature has been 
taken out of its normal state by an external means (faceplate or SCADA), the IntelliNode 
module considers this to be human intervention and will cause the associated team to 
be in a Not-Ready state. It will also prevent automatic operation of the relay/recloser 
device by the IntelliTeam SG system until the condition has been cleared. Options are 
the Supported or Unsupported (default) settings. The Supported setting has Enabled 
and Disabled options when it is enabled.

Ground Trip 
No Ground Trip function for use with the IntelliNode Module/IntelliTeam SG system 
is supported at this time.

Normal Profile 
Set this parameter to the settings profile the host relay/recloser device should use 
under normal circuit conditions. When the parameter is supported and enabled and the 
IntelliNode module detects the settings profile has been changed by an external means 
(faceplate or SCADA), the IntelliNode module considers this to be human intervention and 
will cause the associated team to be in a Not-Ready state. It will also prevent automatic 
operation of the relay/recloser device by the IntelliTeam SG system until the condition 
has been cleared. Options are the Supported or Unsupported (default) settings. When 
the Supported setting is chosen, it has the Normal (default), Alt1, Alt2, Alt3, Alt4, 
and Alt5 setting options.
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Alternate Profile 
Set this parameter to the settings profile the host relay/recloser device should use under 
reconfigured circuit conditions. During a reconfiguration event the IntelliTeam SG 
system will change the active profile to this configured profile as part of the sequence of 
operating the relay/recloser device. When this parameter is supported and enabled and 
the IntelliNode module detects that the settings profile has been changed by an external 
means (faceplate or SCADA), the IntelliNode considers this to be human intervention 
and will cause the associated team to be in the Not-Ready state. It will also prevent 
automatic operation of the relay/recloser device by the IntelliTeam SG system until the 
condition has been cleared.

Note: If the profile is changed during circuit reconfiguration and the automatic 
Return-to-Normal function is enabled, the IntelliTeam SG system logic does not 
reset the profile back as part of the Return-to-Normal process. However, this can be 
accomplished remotely with a SCADA control point operation. Options are the Sup-
ported or Unsupported (default) settings. When the Supported setting is chosen, it 
has Normal (default), Alt1, Alt2, Alt3, Alt4, and Alt5 setting options.
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Figure 11. The Setup>External Device>DNP Status Point Map screen.

Note: Before making changes to any DNP settings here or from the Setup>Communications 
screens, set the Device Data Updates mode to the Stopped state to prevent data from 
being used incorrectly. When the changes are complete, set the Device Data Updates 
mode to the Running state to allow use of the retrieved data.

Point Name
A point name followed by an asterisk “*” indicates a required point.

Point Number
This sets the point’s location in the point map. Click in the Point Number field and select 
a point-mapping number from the pull-down list.

The screen shown in Figure 11 allows programming of the external device status points 
used by the IntelliTeam SG system. The required points are highlighted with an asterisk. 
Additional points should be mapped depending on the protection settings.

External Device Status 
Points
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Active State
Select the active state that is returned from the external device for the associated status 
point number. For example, if Close and Open functions are reported by the same point 
number, and the external device reports the Close function as 1, the Close active state 
is 1 and the Open active state is 0. If Close and Open functions are reported as different 
point numbers, the active state is 1 for both. 

When the Device Data Updates setting on the Operation screen is set to the Running 
mode, the returned status points will be displayed for the programmed points.

The points listed in Table 1 on page 33 are required for IntelliTeam SG system setup.
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Status Point Name Description

Close State● True if the switch mechanism is in the Closed position

Open State● True if the switch mechanism is in the Open position

Lockout Status● True if the relay has tripped to lockout

Normal Profile■ True if the Normal profile is active

Alternate Profile 1■ True if Alternate profile 1 is active

Alternate Profile 2■ True if Alternate profile 2 is active

Alternate Profile 3■ True if Alternate profile 3 is active

Alternate Profile 4■ True if Alternate profile 4 is active

Alternate Profile 5■ True if Alternate profile 5 is active

Grd Trip Blocked True if the relay is indicating trip on ground current is blocked

Grd Trip Enabled True if the relay is indicating trip on ground current is enabled

Reclosing Blocked■ True if the relay is indicating reclosing is blocked

Reclosing Enabled■ True if the relay is indicating reclosing is enabled

Remote Mode Enabled ▲ True if the relay is indicating remote mode is enabled

Trouble Status1 True if the relay is reporting trouble is active

Trouble Status2 True if the relay is reporting trouble is active

Hot Line Tag■ True if the relay has hot line tag active

Freq . Trip Target■ True if the relay has tripped due to frequency anomaly

Trouble Status3 True if the relay is reporting trouble is active

Direction 1 Phase A Fault● True if the relay is indicating an A phase fault has been detected 
in the direction mapped to Direction1

Direction 1 Phase B Fault● True if the relay is indicating a B phase fault has been detected in 
the direction mapped to Direction1

Direction 1 Phase C Fault● True if the relay is indicating a C phase fault has been detected in 
the direction mapped to Direction1

Direction 1 Neutral Fault● True if the relay is indicating a neutral or ground fault has been 
detected in the direction mapped to Direction1

Phase A Volt Present True if the relay is indicating voltage is detected on phase A

Phase B Volt Present True if the relay is indicating voltage is detected on phase B

Phase C Volt Present True if the relay is indicating voltage is detected on phase C

Trouble Status  4 True if the relay is reporting that trouble is active

● Required DNP Point .

■ Required DNP Point if supported by the external device .

▲ The Remote Mode Enabled status point should be mapped . If not mapped or configured N/A 
 it will always be displayed as active .

Table 1. Status Point requirements for IntelliTeam SG System

TABLE CONTINUED ▶
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Status Point Name Description

Recloser Cycle Status◆ True if the relay is fault cycling

Recloser Reset Status■ True if fault cycling has ended and the switch is closed

Direction 1 Sensitive 

Earth Fault■

SEF for the external device . When active, it is treated within the  
IntelliTeam SG System logic the same as an overcurrent fault

Differential Lockout■ Trip for the external device . When active, it is treated within the  
IntelliTeam SG System logic the same as an overcurrent fault with this 
directionality

Ext . Dev . Voltge Trip■ Trip for the external device . When active, it is treated within the  
IntelliTeam SG System logic the same as an overcurrent fault to prevent 
indication of manual operation of the external device as reported to the 
IntelliTeam system . This allows the IntelliTeam SG system to stay in the 
Ready state for events such as a transfer trip of a substation breaker

Bus One Shot Active True if Bus One Shot is active

Bus One Shot Lockout True if Bus One Shot has resulted in lockout

Direction 2 Phase A Fault True if the relay is indicating an A phase fault has been detected in the 
direction mapped to Direction2

Direction 2 Phase B Fault True if the relay is indicating an B phase fault has been detected in the 
direction mapped to Direction2

Direction 2 Phase C Fault True if the relay is indicating an C phase fault has been detected in the 
direction mapped to Direction2

Direction 2  Neutral Fault True if the relay is indicating a neutral or ground fault has been detected in 
the direction mapped to Direction2

Direction 2 Sensative 
Earth Fault

SEF for the external device . When active, it is treated within the IntelliTeam 
SG System logic the same as an overcurrent fault with this directionality

Direction 1 Neg Seq  

Current Fault ■

Negative Sequence Fault for the external device . When active, it is treated 
within the IntelliTeam SG System logic the same as an overcurrent fault 
with this directionality

Direction 2 Neg Seq 
Current Fault

Negative Sequence Fault for the external device . When active, it is treated 
within the IntelliTeam SG System logic the same as an overcurrent fault 
with this directionality

Direction 1 Direction 
Current Flow 

True if the external device is indicating load current flowing in the direction 
mapped to Direction1

Direction 2 Direction 
Current Flow

True if the external device is indicating load current flowing in the direction 
mapped to Direction2

● Required DNP Point .

■ Required DNP Point if supported by the external device .

▲ The Remote Mode Enabled point should be mapped . If not mapped or configured N/A 
 it will always be displayed as Active .

◆ The Recloser Cycle Status point should be mapped if supported by the external device . 

Table 1. Status Point requirements for IntelliTeam SG System−continued
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NOTICE
If the switch Open/Close state is reported as being in both the Open and Closed 
state, a 10-second timer starts . If the status is still the same when the timer expires, 
the team enters the Stop Transfer state, and both a log event message and status 
change are reported .

Figure 12. The Setup>External Device>DNP Analog Point Map screen.

Note: Before making changes to any DNP settings here or from the Setup>Communi-
cations screens, set the Device Data Updates mode to the Stopped state to prevent 
data from being used incorrectly. When completing the changes, set the Device Data 
Updates mode to the Running state to allow use of the retrieved data.

Point Number
This sets the point’s location in the point map. Click in the Point Number field and select 
a point-mapping number from the pull-down list.

Scaling Factor
Phase current is expected to display in units of one amp per count. This sets the scaling 
factor to adjust the reported value.  The Scaling Factor and the Line kV to 120 Vac 
Base Ratio settings are used to convert the external device’s reported phase-voltage 
data to a 120-Vac base. The displayed value will be compared to the configured Extended 
Voltage Loss and Single Phase Voltage Loss Threshold setting on the Setup>External 
Device>Auto Operation screen.

The screen shown in Figure 12 allows programming of the external device analog input 
points used by the IntelliTeam SG system. The required points are highlighted with an 
asterisk. Additional points should be mapped depending on the protection settings.

External Device 
Analog Input Points
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Figure 13. The Setup>External Device>DNP Control Point Map screen.

Note: Before making changes to any DNP settings here or from the Setup>Communi-
cations screens, set the Device Data Updates mode to “Stopped” to prevent data from 
being used incorrectly. When the changes are complete, set the Device Data Updates 
mode to “Running” to allow use of the retrieved data.

Point Name
A point name followed by an asterisk “*” indicates a required point.

The screen shown in Figure 13 allows programming of the external device control points 
used by the IntelliTeam SG system. The required points are highlighted with an asterisk. 
Additional points should be mapped depending on the protection settings.

External Device 
Control Points

Polled Status
This is the actual analog data reported by the external device for that programmed point 
number, with an “applied” scaling factor.

Line kV to 120 VAC Base Ratio
Enter a value to set a 120-Vac base for the displayed three-phase voltages.

Note: These scaling factors do not modify what the external device reports when a 
SCADA Master polls for analog-input data. There are separate scaling factors config-
ured for SCADA DNP.
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Point Number
This sets the point’s location in the point map. Click in the Point Number field and select 
a point-mapping number from the pull-down list.

Object Type
Select from the six object types that the external device supports for the associated 
control point. 

Function
The Direct Operate function is the only function type supported for control points by 
the IntelliNode module or the IntelliTeam SG system. 

Control Test
Click in the Control Test field and select the Execute option from the pull-down menu 
to send this control point to the external device. This facilitates quick verification of the 
Control Point operation and the reported status points.

  WARNING
Selecting the Execute option causes an operation of the external device . Be sure 
all standard safety precautions are followed before testing a point .

Fault Target Timeouts (secs)
The IntelliNode module waits the length of  this timer before it sends the Reset 
Fault Targets control point to the external device. (Minimum: 1; maximum: 255;  
increment: 1; default: 45)

Last Control Point Number
The IntelliNode module doesn’t poll for binary output status from the external device to 
get a count of how many control points the external device supports. So when program-
ming the control points to be used by SCADA (on the Setup>Point Mapping>Controls 
screen), configure this setpoint to the number of control points the external device 
supports. (Minimum: 0; maximum: 255; increment: 1; default: 55)

Control Point Operation Timeout
This value is used by the IntelliTeam SG system as the upper limit for how long a control 
point operation will run. Successful operation time is based on the polling rate and the 
returned status point associated with that control point. (Minimum: 10 s; maximum:  
25 s; increment: 0.1 s; default: 10.0)

Control Relay Pulse On/Off Time (ms)
The on and off times in the control relay output block are programmable. (Range: 
0-4,294,967,295 ms; increment: 1; On time default: 1; Off time default: 0) 
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The points listed in Table 2 are required for IntelliTeam SG system setup.

Table 2. Control Point requirements for the IntelliTeam SG System
Control Point Name Description

Normal Profile● Command to enable the normal settings profile of the host control device

Alternate Profile 1● Command to enable the alternate settings profile 1 of the host control device

Alternate Profile 2● Command to enable the alternate settings profile 2 of the host control device

Alternate Profile 3● Command to enable the alternate settings profile 3 of the host control device

Alternate Profile 4● Command to enable the alternate settings profile 4 of the host control device

Alternate Profile 5● Command to enable the alternate settings profile 5 of the host control device

Trip■ Command to open the contacts of the breaker or recloser

Close■ Command to close the contacts of the breaker or recloser

Ground Trip Blocked Ground trip for use by the IntelliNode module and IntelliTeam SG system is 
not supported at this time

Ground Trip Enabled Ground trip for use by the IntelliNode module and IntelliTeam SG system is 
not supported at this time

Reclosing Blocked● Command to block the reclosing feature of the host control device

Reclosing Enabled● Command to unblock the reclosing feature of the host control device

Reset Fault Targets▲ Command to clear the fault targets in the host control device

● Required DNP Point .

■ Required DNP Point if supported by the external device .

▲ Not required if host device automatically clears fault status when it closes .
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Figure 14. The Setup>External Device>Communications screen.

Note: Before making changes to any DNP settings here or from the Setup> 
Communications screens, set the Device Data Updates mode to “Stopped” to prevent 
data from being used incorrectly. When the changes are complete, set the Device Data 
Updates mode to “Running” to allow use of the retrieved data.

Module-to-External Dev. DNP Port
Enter the serial port connected to the external device: UDP port A, B, C, or D.

External Device IP Address
Enter the IP address of the external device when Ethernet is used for the connection.

Module-to-External Dev. Polling Interval 
The IntelliNode module polls the external relay/switch device for data and stores that 
data in an internal database. This parameter defines the interval (in seconds) that this 
polling will be repeated. (Minimum: 1; maximum: 5; increment: 0.1; default: 1.2) 

These setpoints are specifically for communication with the external device. See  
Figure 14.

External Device 
Communications
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Module-to-External Dev. Polling Timeout 
This is the amount of time (automatically calculated) the IntelliNode module waits before 
logging a communication timeout. For the normal data polls, when a timeout occurs, the 
pending message is deleted off the transmit list and another poll is sent. Enter the Polling 
Interval setting, go to the Setup>External Device>Start screen, and set the Verbose 
Ext. Dev. Polling Log setpoint to “Enabled.” Set the Device Data Updates setpoint 
to “Running.” Go to the Logs>Historic Log screen and verify the Data Poll Sent to Ext. 

Device and Data Received from Device events are logged without a timeout being 
logged. When this is completed, go to the Setup>External Device>Start screen and set 
the Verbose Ext. Dev. Polling Log setpoint to “Disabled” so the compact flash doesn’t 
fill up with these messages.

External Device RTU Address
This is the DNP RTU address configured in the external relay/switch device directly 
connected to this IntelliNode module. This RTU address must be unique within the 
communications system.

NOTICE
IntelliLink Software Users: Changing the RTU address or other communication 
param eters can stop this device from communicating remotely with IntelliLink Setup 
Software and its other team members . The IntelliTeam SG system stops working 
when it can’t reach a team member . If communication with a control is lost, the 
operator must go to the site, connect directly to the control, and reset the RTU 
address, or other changed communication parameter .

Binary Input Variation
This is the DNP object variation used in the IntelliNode module’s poll to the external 
device for binary input data. Using the Any Variation setting allows the external device 
to select the variation of the binary input data it will respond with.

Selecting the Binary Input with Status setting causes the IntelliNode module to 
look at the offline status of every binary input returned by the external device. When 
an offline status is found, an alarm condition is entered and any IntelliTeam SG system 
activity will be stopped. Choices are: Any Variation (default), Binary Input, and Binary 
Input with Status settings.

Binary Input Qualifier
This is the DNP qualifier code used in the IntelliNode module poll to the external device 
for binary input data. The no range field all points qualifier requests that all available 
binary input data points be returned in the external-device response.

Note: The IntelliNode module only supports 216 binary status points.
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Poll for Binary Input Change with Time
When the external device is set for fast fault cycling and a slow polling interval is con-
figured, valuable information occurring between the polling intervals may be missed. 
When set to “Yes,” the IntelliNode module polls for binary change events and any active 
fault current or voltage loss event will be reported to the IntelliTeam SG system.

Note: If there are too many events stored in the external device (events haven’t been 
polled for a long time), the time it takes to receive all of them might exceed the Poll 
Timeout value, resulting in a Reset Link command being sent to the external device 
instead of a confirmation acknowledgement. The events will not be purged from the 
external device and the process repeats. First purge old events from the external 
device and then enable this setpoint. The TRANSMIT and RECEIVE LEDs for the port 
connected to the external device should show one Transmit indication followed by 
one Receive indication.

Clear Binary Inputs on Loss of Communication
When set to the Yes setting, it causes clearing of all binary status data that have been 
returned by the external device when communication is lost. Clearing the binary input 
points also applies to points from the external device that are mapped to SCADA points.

Analog Input Variation
This is the requested DNP object variation of analog input data. The Any Variation 
setting allows the external device to select the analog input data variation it will respond 
with. Choices are: Any Variation (default), 16 Bit without Flag, and 16 Bit settings.

Note: The IntelliNode module supports only 16-bit analog values. If the Any Variation 
setting is used, be sure the external device is configured to return 16-bit analog values.

Analog Input Qualifier
This is the requested DNP qualifier code for analog input data. The No Range Field All 
Points setting requests that all available analog input points are returned in the external 
device response. This is the only option.

Note: The IntelliNode module only supports 126 analog input points.

Binary Counter Variation
This is the requested DNP object variation of binary counter data. For the Any Variation 
setting is used, the external device selects the variation of binary counter data it will 
respond with. This is the only option. 

Note: The IntelliNode module supports up to 32-bit counters.

Binary Counter Qualifier
This is the requested DNP qualifier code for binary counter data. For the No Range Field 
All Objects setting is used, all available binary counter data objects are returned in the 
external device response. This is the only option.

Note: The IntelliNode module only supports 16 binary counters.
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Figure 15. The Setup>Communications>DNP screen.

DNP communication settings for the IntelliTeam SG Automatic Restoration System, 
SCADA, and IntelliLink Setup Software are configured on the screen shown in Figure 15

Communication Setup

Analog Output Data Size
This setpoint matches the data size supported when DNP receives a request to set one 
of the 16 mapped analog output points that will be sent to the external device. Options 
are 16 Bits (default) or 32 Bits settings.

Total Binary Status Points, Total Analog Input Points, and Total Binary 
Counter Points
To help verify the IntelliNode module is receiving data from the external device, these 
real-time counts are the totals received. If 38 binary status points are displayed with a 
zero reference, the device is returning 0-37.

Note: The IntelliNode module sends three DNP objects to the external device: Sta-
tus Points, Analog Input Points, and Counter Points. For correct operation, the 
external device can respond to all three, or it can return data for just status points and 
analog input points.
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Local Device DNP Address
Enter the network address for this control. It must be the same as the DNP/RTU address 
on the Setup>Restoration>IntelliTeam SG>Team Summary screen. Be sure to enter 
an address even if this control will not be accessed via SCADA or a remote IntelliLink 
software connection. The DNP address must be greater than 0; 1 is the default, and the 
maximum value is 65519.

NOTICE
Changing the DNP address or other communication parameter can prevent 
the control from communicating with other team members in an IntelliTeam SG  
system and via SCADA or a remote IntelliLink software connection . If  
communication is lost with a control, go to the site, connect through IntelliLink 
software, and reset the communication parameter that had been changed .

NOTICE
Make sure to enter the new DNP address when relocating a configured control to 
a new site . If failing to do so, the control may respond to commands intended for a 
different location .

Number of Retries for Confirm
This is the number of times the control will resend a data-filled unsolicited message 
to the master station if a confirmation message is not received within the Time Delay 
Between Retries setting. The control will save the event data after this number of retries 
until it receives a confirmation. If there is no confirmation after the number of retries 
is exceeded and a new event occurs, the control will resend the saved event data along 
with any new event data. Setting this parameter at 0 will prevent retries. This setting 
applies to all masters. (Range: 0-10; Step: 1; Default: 6)

Time Delay Between Retries
This is the time delay between retries for initial unsolicited null and data-filled unsolicited 
responses. The initial unsolicited null is transmitted indefinitely until the master confirms 
it. Data-filled unsolicited responses are transmitted until the number of retries specified 
in the Number of Retries for Confirm setting has been reached. Transmission retries 
stop when an application confirmation is received from the master during this period.

For master event requests, this is the application confirmation timeout period. When 
the control receives a confirmation after this timer has expired the confirmation will 
be ignored and the events will remain in the event buffers. This setting applies to all 
masters. (Range 0.100-65.535 seconds; Step: 0.001; Default: 5.000)

NOTICE
When the master will set or read an Application Layer Confirmation Retry Time 
longer than 32 .767 seconds: to set it, use Group 41 variation 1 (32-bit) to read it 
use Group 40 variation 1 (32-bit with flag) . Otherwise, a SCADA poll may report a 
negative value because the default configuration is 16-bit . Review S&C Instruction 
Sheet 1043-561 “S&C IntelliNode™ Interface Module: Configurable DNP Points 
and Implementation,” for more information .
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Output Block Point Select Timeout
This is the timeout duration of the Select function on control points. See the appropriate 
S&C Instruction Sheet 766-560, 1043-561, 1045M-560A, 1045M-560B, 1045-560, 1045-560B, 
1045-560C, 1045-560D, 1045-560E, or 1045-560F: “DNP Points List and Implementation.” 
If the timeout duration between Select and Operate functions during a Select-Before-
Operate sequence exceeds this timeout value, the control will disable the point and 
return a timeout status code in the subsequent Operate request. This setting applies to 
all masters. (Range: 1.0-100.0; Step: 0.1; Default: 10.0)

Use of Self-Address 65532

NOTICE
Disabling the Use of Self-Address setting can prevent the IntelliNode  
module from communicating with IntelliLink software . If communication with the  
IntelliNode module is lost, the user must know the Local Device DNP Address 
setting, connect through a remote IntelliLink software connection, and re-enable 
the Use of  Self-Address setting to connect locally .

Wi-Fi will not work if the Use of Self-Address setting is disabled . If the local 
DNP address is not known and the Use of Self-Address setting is disabled, the 
IntelliNode module will require reprogramming at the factory to re-establish access 
to the control .

This setting is present to comply with the DNP standard. Care must be used when deciding 
to change the default. Options are “Disabled,” which blocks the use of DNP Address 
65532, and”Enabled,” which allows the use of DNP Address 65532. Default is enabled.

Limit Unknown Master Functionality

NOTICE
Enabling this feature prevents unknown master stations from making any  
configuration changes . When the Limit Unknown Master Functionality setting is 
enabled, at least one master other than the SCADA master must be enabled .

When this feature is enabled, the only way to connect with the control (to make any 
changes or disable this feature) is with IntelliLink software and a computer set to 
the configured DNP address of the enabled master that is not the SCADA master . 
The control must be returned to the factory and reset to the factory default when the 
DNP address of the master is unknown .

The default is the Disabled setting to allow master station addresses to be entered into the 
configuration. After those addresses have been entered, this parameter may be enabled 
and a configured master station address used to complete the configuration process.

When enabled, a master/peer station not included in the configuration of this control 
is prevented from writing to or controlling it. Master/peer stations configured in this 
control include any of the six master station DNP addresses and team members config-
ured on the Setup>Restoration>IntelliTeam SG>Team Summary screen. The default 
is the Disabled setting.
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Enforce Master Association
The primary identification for a master station is its DNP address. When a master sends 
DNP requests to a control and this setting is enabled, the Master’s port code (i.e. TCP, UDP, 
or serial), IP address (when the port code is TCP or UDP), and DNP address must match 
the data configured for that master station in the control. DNP requests are ignored when 
this setting is enabled and the IP address and port code do not match the configured data.

When this setting is disabled the IP address and port code are ignored, and only the DNP 
address is checked and validated with the control configuration. Note that configuring 
the Failover IP Address setting is optional; when the Enforce Master Association 
feature is enabled, the master station IP address must match either the configured 
IP Address or the Failover IP Address setting. For this feature to work, the Limit 
Unknown Master Functionality feature must be enabled. The allowable port values 
are 20,000 - 20,999 and 49,152 - 65,535.

Use Verbose Diagnostic DNP Logging
When the Enabled setting is selected (for diagnosing a communication issue), a message 
is logged for every source and destination frame. Enabling this function for an extended 
period will cause Historic logs to fill quickly and reduce the number of saved historical 
events. The Disabled setting is the default.

DNP Application Layer Confirmations
When the Enabled setting is selected, an application layer confirmation will be requested 
with every solicited response that includes event data. Event buffers will not be cleared 
until an application layer confirmation is received from the master station. When disabled, 
the event buffers are cleared when events are reported. The Enabled setting is the default. 
This setting applies to all masters.

Maximum Transfer Unit (all product software except ST6801MSS)
This setting allows the IntelliTeam SG system to make the most efficient use of com-
munication system bandwidth. For SpeedNet™ Radios, set it to 500. For an Ethernet 
connection, set it to 1500. For other communication devices, set it to the maximum 
packet size of the device. The Maximum Transfer Unit is only used for IntelliTeam SG 
system communications and can be set to the default setting for any control not using 
the IntelliTeam SG system. (Range: 205-2,048; Step: 1; Default: 500)

Note: When pushing Netlists using IntelliTeam Designer, an MTU of 500 or higher is 
required.

Peer-to-Peer Interpacket Delay
Set this to zero unless the IntelliTeam SG system is enabled. Interpacket delay improves 
communication reliability between team members by adjusting the delay between succes-
sive frames of a multi-frame P2P fragment. The Maximum Transmission Unit setting 
defined for that control determines frame size.

When data traffic is heavy, a peer’s receive buffer may overflow, and messages could 
be lost. This problem is usually noticed in a direct P2P/UDP system. The Interpacket 
Delay setting increases the time a peer will have to process received data. It is advis-
able to increase the receive buffers instead of increasing the Interpacket Delay setting, 
which will create artificial delays in the communication system. (Range: 0.0-10.0; Step: 
0.5; Default: 0.0)
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Local DNP Time Offset
When the Disabled setting is selected, UTC time is applied to the DNP timestamps. 
When a local time offset ranging from +14 hr. to -14 hr. in 15-minute increments has been 
selected, the offset is applied to the UTC time to allow the DNP time stamp to be adjusted 
to local time. The Disabled setting is the default.

TCP Keep-Alive Timer
This specifies the time between keep-alive messages as defined in the DNP specification. 
This setting applies to all masters. (Range: 5-7200; Step: 1; Default: 300)

TCP End Point
A listening end point can be configured to report unsolicited events but it cannot initiate 
a connection, it must wait for the master to connect and then report unsolicited events. 
A dual end point can initiate a connection if there is not an active connection already 
present.

DNP Counter Type (not applicable for IntelliRutper® fault interrupters)
This selects the counter that will be reported in static data for a Class 0 Poll requested 
by the master station. Counter selections are Frozen, Running, and Both Counters 
(default) settings.

Unsolicited Transmit Delay Event Count
This is the number of new events that will cause an unsolicited message to be transmitted,  
provided the Unsolicited Transmit Delay Time setting has not been reached. Setting 
this parameter to 1 results in an unsolicited message generated for every new event. This 
setting applies to all masters. (Range: 1-60; Step: 1; Default: 10)

Unsolicited Transmit Delay Time
This is the maximum time (in seconds) that may elapse after a new event before an unso-
licited message is sent. During this delay other new events may be added to the message. 
If the number of events reaches the Unsolicited Transmit Delay Event Count setting 
before the delay time elapses, the unsolicited message will be sent immediately. This 
setting applies to all masters. (Range: 0.1-120.0; Step: 0.1; Default: 5.0)

Unsolicited Retried Indefinitely
Enabling this setting allows unsolicited message retries to be performed until a confir-
mation is received, and the Number of Retries for Confirm setting will be ignored. 
Disabled is recommended for normal operation. This setting applies to all masters.

Report Last Analog Input Event Only
When the Report Last Analog Event Only setting is set to “Enabled,” only the latest 
DNP analog input events will be reported for a DNP analog input point (both solicited 
and unsolicited messages); otherwise, all analog input point changes will be reported 
when this setting is “Disabled,” which is the default.

Allow Remote Restart
When the Allow Remote Restart setting is set to “Enabled,” the control performs a 
restart on receipt of a request to perform a cold restart or a warm restart from a master 
station.
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Master Stations 1 through 6

Master Station Functionality
When Enable Master Functionality is checked, several features are provided to the master:

• Event data are saved until the master confirms receipt of the data (or just polls the data 
if the DNP Application Layer Confirmations setting is disabled). Each of the masters 
has its own event data, so if one of the masters has retrieved and confirmed receipt 
of the data, the other masters can still retrieve the data they have not yet received. 
(Unknown/unregistered masters may still receive event data through polling, but they 
will only receive the data that have not yet been confirmed/received by Master 1.)

• The Unsolicited Reporting by Exception feature for event data is available.

• The Limit Unknown Master Functionality setting (if enabled) does not apply to 
these masters.

No master can have the same DNP address as the local device. All masters must have 
unique DNP addresses. In order to properly clear event buffers the port code must match 
the connection type and the proper IP address must be associated with the DNP address.

DNP Address
This is the DNP address to which the control sends all unsolicited responses. This is 
also used to verify whether a master is one of the registered masters. (Range: 0-65,519; 
Step: 1; Default: 0)

IP Address (if applicable)
This is the IP address to which the control sends all unsolicited responses (if enabled). 
It is also used to verify whether a master is one of the registered masters (both DNP 
and IP addresses must match). An IP address of 0.0.0.0 is represented as blank on the 
IntelliLink software screen. When using serial communications specify the DNP master 
address and the serial port to be used. All other IP related parameters are ignored. The 
listening port for incoming TCP connections and UDP packets is hard coded at 20,000.

Entering an IP Address
IP address entry has been simplified, follow these steps:

STEP  1.  Click and highlight the character in the first cell.

STEP  2.  Type one to three characters as needed.

STEP  3.  Hit the space bar to advance to the next field. Advancing in this fashion 
automatically highlights the characters in the next field.

STEP  4.  Repeat typing, followed by the space bar until entry is complete.

To revert to the IP address value presently configured in the control memory, press 
the <Esc> key or click the Reset button in the tool bar.

IP Address FAILOVER (if applicable)
The local control sends unsolicited messages (if enabled) to any registered master it 
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has received a message from (provided that master has sent an Enable Unsolicited 
Messages command, if the Unsolicited Response Mode function is set to the Normal 
setting). The local control will respond to either the Primary master or the Failover  
master, whichever sent the last message. The IP address in use will be highlighted. If there 
is no Failover setting configured for this master, leave this entry blank or enter 0.0.0.0.

Port Code
This is the port through which unsolicited report-by-exception DNP frames to the master 
station are sent. Port A (serial) is the default. Select the TCP option if the SCADA master 
is configured for a TCP/IP connection, and select the UDP option if the SCADA master 
is configured for UDP/IP.

The port code also is used to check that an incoming message is from a registered 
master. In addition to the DNP address and IP address (if TCP or UDP is used), the port 
code must also match.

Port Number
This setting is ignored unless the TCP or UDP option has been selected for the master 
station port code. This port is the outgoing port for unsolicited TCP or UDP messages 
that occur when there isn’t an active session with the master. (Range: 1,024-65,535;  
Step: 1; Default: 20,000)

Note: The UDP option uses the fixed port 20,000 as the source port for all UDP 
messages.

Note: When the Enforce Master Association and Limit Unknown Master options 
are enabled, the valid UDP port number must be in the following range: 20,000-20,999; 
49,152-65,535.

TCP Interface
When configuring the IP address (if applicable), set this to the Ethernet port associated 
with that IP address. This setting is ignored unless the TCP option has been selected 
for the master station port. Select the Add-On or Native setting. The Not TCP option 
is a placeholder and is not applicable. Select the Add-On setting for IntelliRupter fault 
interrupters because they do not have a native Ethernet port.

Unsolicited Responses
When enabled (the default), the control sends a message to the master station when new 
event data are available based on the Unsolicited Transmit Delay Event Count setting 
and the Unsolicited Transmit Delay Time setting. A master station DNP address and 
master station port code or master station IP address must be entered. Enabling this 
feature may add significant traffic to the communication network.

Unsolicited Response Mode
Select the Normal (default) or 5800 V2 Mode setting.  The Normal mode requires the 
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Master Station to acknowledge an initial empty (null) unsolicited message at control 
restart. The SCADA master must send a command to enable unsolicited reporting.

If acknowledgment of the initial empty unsolicited message is not received, the control 
continues to resend these messages at the configured retry interval until an acknowledg-
ment is received. The 5800 V2 Mode setting is a non-standard mode that bypasses the 
initial empty unsolicited messages and the requirement for the master station to enable 
unsolicited reporting with a SCADA command. It simply starts sending unsolicited 
responses as events occur, provided that the unsolicited responses parameter is enabled.

The 5800 V2 Mode setting may require that the control be restarted unless the 
control is presently sending unsolicited responses in the Normal mode or a remote 
command to enable unsolicited responses can be sent to the control. To restart the control 
after all configuration changes have been successfully applied, select Tools>Device  
Maintenance… option on the menu bar, and select the Reset Control option and click on 
the Yes option in the dialog box. Afterward, log in when the IntelliLink dialog box opens.

Failover IP Address (if applicable)
Each of the six master stations can have up to four Failover IP addresses registered. 
The local control sends unsolicited messages (if enabled) to any registered master it 
has received a message from (provided that master has sent an Enable Unsolicited  
Messages command, if the Unsolicited Response Mode setting is set to the Normal 
state). The local control will respond to either the primary master or the failover master, 
whichever sent the last message. The IP address in use will be highlighted. If there is 
no Failover setting configured for this master, leave this entry blank or enter 0.0.0.0.

Failover TCP Interface (if applicable)
Each of the six master stations can have up to four Failover TCP Interfaces configured. 
Select the Add-On setting for IntelliRupter fault interrupters.
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Figure 16. The Setup>Communications>Serial Ports screen.

Ports A, B, C, and D

Communication Protocol
DNP is permanently configured because S&C controls only use the Distributed Network 
Protocol. (Default: DNP)

Communication Baud Rate
This is the baud rate from the S&C control to the radio, and it must be identical to the 
baud rate of the radio. (1 200, 2 400, 4 800, 9 600, 19 200, 38 400, 57 600 (default),115 200, 
and 230 400 baud)

The screen shown in Figure 16 contains communication settings related to the 
IntelliTeam SG Automatic Restoration System, SCADA, and IntelliLink Setup Software. 
S&C automation products have different serial-ports configurations:

IntelliNode Interface Modules have four configurable serial ports.

Serial Port Setup
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Figure 17. The Setup>Communications>Routing screen.

Address Mapping  

RTU Address
When an incoming message frame is received that is not destined for the local device, 
these addresses are searched to find an active route.

IP Address
This parameter should be configured if the destination device is on an IP network. The 
received frame will be transmitted out the local UDP port.

Port
This parameter should be configured if the destination device may be found through a 
serial communications port. The received frame will be transmitted out the local serial 
port.

The screen shown in Figure 17 can display routing information for up to 32 destination 
devices. If a message frame is received with a destination address other than the local 
address, this information is used to redirect the message out an adjacent port. The frame 
will be dropped if the destination address is not included in the routing table and a default 
pass-through route has not been configured.

Routing Setup

RTS Active Before/Following Xmit
This is the time in milliseconds the request to send (RTS) is active for this port before 
and after a transmission takes place. The default value is usually suitable. (Range: 0-995; 
Step: 5; Default: 0)

Interpacket Delay
This is the time in milliseconds between individual message frames of a data stream. Set 
this parameter appropriately for the radio. (Range: 0-995; Step: 5; Default: 50)
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Figure 18. The Setup>Communications>Ethernet screen.

IntelliNode Interface Modules have both Native and AddOn ports. See Figure 18.Ethernet Setup

Local Device DNP Address
Contains entries that define default routing for messages that are addressed to devices 
that were not found in the configured routing table and are not the local device. This 
default routing performs a simple pass-through functionality between the two interface 
points. If not wanting unknown traffic to be routed through this device, leave these 
entries unconfigured.

IP Addresses
This parameter should be configured if the intended destination device may be found 
on the IP network. This will cause the received frame to be transmitted out the local 
UDP port.

Port
This parameter should be configured if the intended destination device may be found 
through a serial communications port. This will cause the received frame to be transmit-
ted out the configured local serial port.
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IP Address
The IP address of the control.

Network Address
The IP address of the network. The IP address entered must be an address within the 
network. The relationship between the IP Address entry and the Network Address entry 
is defined by the Subnet Mask entry.

Subnet Mask
This is a 32-bit mask that divides an IP address into subnets and specifies the available 
hosts. Two bits are always automatically assigned. For example, in 255.255.255.0, “0” is 
the assigned network address; and in 255.255.255.255, “255” is the assigned broadcast 
address. The “0” and “255” are always assigned and cannot be used.

Broadcast Address
This is the address used to distribute a signal across a network. It is commonly used to 
declare that a new device has been connected and to provide information about the device 
to existing devices on the network. The broadcast address commonly ends with “255.”

MAC Address
This is the MAC address assigned to the control’s Ethernet port.

Auto-Negotiate
The Auto-Negotiation setting can be enabled for the Ethernet port. When disabled, the 
Duplex Mode selection and Data Rate setting must be configured.

NOTICE
The native port of units shipped before April 17, 2014, does not support  
Auto-Negotiate functionality . The recommended solution is to connect the  
communication device to the AddOn port . If it is necessary to use both ports, turn 
off the Auto-Negotiate function and explicitly set the port speed to 100 MBS . 
Looking at the bottom of the front panel with the faceplate at the top, the left port is 
the Native port and the right port is the AddOn port .

Duplex Mode
The Full Duplex setting permits simultaneous communication in both directions. The 
Half Duplex (default) setting permits communication in one direction at a time.

Data Rate
This can be set to 10 Mbit or 100 Mbit. (Default: 10 Mbit)
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Default Gateway Address
A gateway is a node (a router) on a computer network that serves as an access point to 
another network. A default gateway is the node on the computer network that is chosen 
when the IP address does not belong to any other entities in the routing table.

The default gateway address is the Ethernet IP address of the radio in the control.

IP Routing Table
This table is used to route data to specific network destinations. All controls (except 
IntelliRupter fault interrupters) have two Ethernet ports: Native and AddOn. When both 
ports have different IP addresses but identical network addresses and subnet masks, 
issues may exist because packets may mistakenly be sent out of the wrong interface. If 
both ports are configured with different network addresses and/or subnet masks, then 
filling out this table is not required. 

The table can accommodate 16 entries for 16 possible rules. Variables are entered in 
IPv44 dot-decimal notation (xxxx.xxxx.xxxx.xxxx) and the network-destination priority 
is from first to last. When the source IP matches a rule, the corresponding destination is 
automatically selected and further routing is abandoned. The IP Routing Table has higher 
priority than the regular port routing (based on Ethernet settings). When the IP Routing 
Table is parsed and no rule is found to match, the regular routing function will be used.

All controls (except IntelliRupter fault interrupters with the SDA-4540R2 control 
module) have two Ethernet ports: Native and AddOn. When both ports have different IP 
addresses but identical network addresses and Subnet Masks, issues may exist because 
packets could mistakenly be sent out of the wrong interface. When both ports are con-
figured with different network addresses and/or subnet masks, then filling out this table 
is not required.

Network Destination
This is typically the IP address of the client machine that wants to connect to a specific 
interface address. 

Subnet Mask
This is typically 255.255.255.255, which means only one specific address is directed to the 
specified interface. However, by carefully selecting the netmask values and defining the 
priority rules, it is possible to create a range of addresses directed to specific interfaces.

Gateway
This is typically the IP address of the Ethernet port (Native or AddOn) on the control.
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Figure 19. The Setup>Communications>Communication Tests screen.

Scheduled Test  
Diagnostic tests determine that nodes are responding to communication and how quickly 
they respond. Statistics are recorded, such as response time, failure, and retry. Tests are 
scheduled periodically and typically run for one hour. Any network node can send tests 
to other network nodes. One or more test message types (Data types, such as a coach or 
runner) can be configured but do not contain real data. See Figure 19.

Communication Tests 
Setup
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NOTICE
Running scheduled tests across a slower-speed communication network may cause 
poor performance . S&C recommends keeping all settings at their default or lower  
values when running these tests on slower communication networks .

Note: The tested nodes are determined automatically based on the nodes entered on 
IntelliTeam system configuration screens.

Test By
Test duration option can be selected: By Time—the amount of time it will run, or By 
Message—the total number of messages it will send. (Default: By Time)

Time Duration
When the Test By Time option is selected, the Time Duration field sets the number of 
hours the test will be run. (Range: 1-23; Step: 1; Default: 1)

Message Duration
When the Test by Message option is selected, the Message Duration field will set the 
number of messages that will be sent. (Range: 100-1,000; Step: 100; Default: 100)

Repeat
This is the retest schedule interval setting: None, Daily, Weekly, or Monthly. (Default: 
Daily)

Time Between Messages
This is the number of seconds between each message transmission. The first test message 
is sent to each node sequentially, then the second test message is sent to each node 
sequentially, etc. (Range: 1-120; Step: 1; Default: 5)

Next Start Time
This field is blank until the first start time is entered. After the next test, the field updates 
automatically to show the next time a test will start. The Next Start Time function is 
determined by the previous start time (entered manually or updated automatically from 
the last test) and the configured repeat interval. 

Note: Users are not allowed to set a date or time in the past.

Link Keep Alive Test  
When a TCP or UDP connection remains idle it may shut down. A link keep alive event 
is not a test, but to keep all links active it periodically sends a single message to every 
node. If more than one message is configured for the scheduled test, the link keep alive 
event only sends the first configured message. It also records statistics for the message 
transmissions. 

Frequency
This sets how often a link keep alive event is run. (Range: 1-60 minutes; Step: 1 minute; 
Default: 4 minutes)
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Ping and Serial Link Test  
A ping test is a manually sent Ethernet ping to a specific IP address. A serial link test is 
a manually sent ping over a serial port to a specific DNP address.

Ping Test Timeout
If a ping test return takes longer than this configured value, the ping test event will 
timeout and stop waiting for a response. Set this value in milliseconds. (Range:  
500-5,000; Step: 500; Default: 5,000)

Serial Link Test Timeout
If a serial link test return takes longer than this configured value, the serial link test 
event will timeout and stop waiting for a response. Set this value in milliseconds. (Range: 
500-30,000; Step: 500; Default: 5,000)

Data Types  
This configures each message sent in a scheduled test. The predefined data types messages 
sent are not actual coach or runner messages, but they’re configured to represent the 
approximate size of an actual average coach or runner message. The definable data 
types allow users to define their own messages by setting the byte size of the sent and 
received messages.

Predefined Data Types
The Connection ID in Row 0 is always configured “Coach” and Row 1 is always configured 
“Runner.” The Bytes Sent and Bytes Received fields are not configurable.

Data Types
The Connection IDs in Row 2 and 3 are always configured “Undefined” whereas the Bytes 
Sent and Bytes Received fields are user defined. If one “Unused” entry is changed, a 
numerical entry must also be entered for the other field in that row.

Row
This identifies the row: 0 is the first message type sent, 1 is the second message type 
sent, etc. 

Data Type
This is the name of the configured test message, such as Coach or Runner. The message 
sent is not an actual coach or runner message, but it should be configured to represent 
the approximate size of the average coach or runner message by setting the appropriate 
number of sent and received bytes.

Bytes Sent
This field configures the length of the message being sent for this type. (Range: 1-2048 
and Unused; Step: 1; Default: Unused)
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Figure 20. The Setup>Communications>DNP Diagnostics screen.

Acknowledge Coach Messages Every “N” Messages
This configures the number of messages required before an acknowledgement is sent, 
where “N” is the number of messages. When 10 is entered, every 10th coach message will 
be acknowledged. (Range: 1-100 and NoAck; Step: 1; Default: 1) See Figure 20.

Acknowledge Runner Messages Every “N” Messages
This configures the number of messages required before an acknowledgement is sent, 
where “N” is the number of messages. When 10 is entered, every 10th runner message 
will be acknowledged. (Range: 1-100 and NoAck; Step: 1; Default: NoAck)

Good Link Health Threshold
This configures the percentage of successful message transmissions that will define good 
link health. (Range: 85-99; Step: 1; Default: 95)

Marginal Link Health Threshold
This configures the percentage of successful message transmissions that will define  
marginal link health. (Range: 5-84; Step: 1; Default: 25)

Other DNP V3 Addresses to Monitor

Selected DNP Addresses
These DNP addresses can be monitored, check the box to select an address to monitor. 
(Default: Unchecked)

Peer Communications Statistics Configuration  DNP Diagnostics 
Setup

Bytes Received
This field configures the length of the response message automatically generated when 
the remote node receives the sent message. (Range: 1-2048 and Unused; Step: 1; Default: 
Unused)
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Figure 21. The Setup>Point Mapping>Status screen.

Status Point
This is the point number the SCADA system will see in response to a static or event data 
request or an unsolicited event response.

The screen shown in Figure 21 contains configuration parameters for DNP status points. 
Map these points to make them available in the SCADA system.

DNP Status Points

Activate button
Every time a DNP address is checked or unchecked for monitoring, click on the Activate 
button.

Last Activation Time
This timestamp indicates the last time the Activate button was clicked.
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Figure 22. The Setup>Point Mapping>Analog Inputs screen.

The screen show in Figure 22 contains configuration parameters for analog input points. 
Map these points to make them available in the SCADA system.

DNP Analog Input 
Points

Code-Description
These are the point codes representing specific status points that may be assigned to 
individual SCADA point numbers. Setting a code-description to the end descriptor defines 
the end of the configured points list and the maximum number of status points that can 
be returned.

Status points received from the external device may be mapped to individual SCADA 
points. Enter the external device status point number (the range is 0 to 255) in this column. 
See the external device manufacturer’s documentation for definitions of its status points.

Class
This is the DNP event class in which this point can be placed. Choose Class 1,  
Class 2, or Class 3, or the No Event option (if event data reporting is turned off for 
this point).
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Analog Point
This is the point number seen by the SCADA system in response to a static request, event 
data request, or an unsolicited event response.

Code-Description
These are the point codes that represent specific analog inputs that may be assigned 
to individual SCADA point numbers. Setting a code-description to the end descriptor 
defines the end of the configured points list and the maximum number of analog inputs 
that can be returned.

Analog input points received from the external device may be mapped to individual 
SCADA points. Enter the external device analog input point number (the range is 0 to 
255) in this column. See the external device documentation for definitions of its analog 
input points.

Event Class
This is the DNP event class assigned to this point. Specify Class 1, Class 2, or Class 3, or 
choose the No Event option to turn off event data reporting for this point.

Scaling
This is the scaling factor for the analog input data, to match the analog input require-
ments of the SCADA system.

Pct DeadBand
This is the deadband range expressed as a percentage of the previously reported analog 
input data. If the analog input data associated with this point exceed the range in either 
a positive or negative direction, the information will be included in the next event report. 
Specify the N/A option to turn off deadband reporting as a percentage of the previously 
reported analog input data.

Fixed DeadBand
This is the deadband range expressed as a fixed value relative to the previously reported 
analog input data. If the analog input data associated with this point exceed the range in 
either a positive or negative direction, the information will be included in the next event 
report. Specify the N/A option to turn off deadband reporting as a fixed value relative to 
the previously reported analog input data.
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Control Point
This is the point number the SCADA system will use when operating the control point.

Code-Description
These are the point codes representing specific control points that may be assigned 
to individual SCADA point numbers. Setting a code-description to the end descriptor 
defines the end of the configured points list and the maximum number of control points 
that can be returned.

Figure 23. The Setup>Point Mapping>Controls screen.

The screen shown in Figure 23 contains configuration parameters for control point 
mapping. Map these points to make them available in the SCADA system.

DNP Control Points
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Object Type
This specifies the type of control code the SCADA master will use in the control relay 
output block request. Specify “Breaker” for a Trip/Close operation, “Latch” for a Latched 
On/Off operation, “Pulse” for a momentary control output, or “N/A” if the control point 
will not be used.

The object type must be valid for the selected object. For more information see 
S&C Instruction Sheet 1043-561, “IntelliNode® Interface Module: DNP Points List and 
Implementation.” The control operation will be rejected if the object type received is 
“Pulse” and the mapped object type is either “Breaker” or “Latch,” or if the mapped object 
type is “Pulse” and the received object type is either “Breaker” or “Latch.”

Every control point configured for “Breaker” accepts Latch operations and every 
control point configured for “Latch” accepts Breaker operations.

Function Codes
Control requests may be issued using Select/Operate sequence, Direct Operate, and 
Direct Operate No Ack function codes.

Figure 24. The Setup>Point Mapping>Analog Outputs screen.

The screen shown in Figure 24 contains configuration parameters for analog output 
points. Map these points to make them available in the SCADA system.

DNP Analog Output 
Points
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Analog Point
This is the point number the SCADA system will use when operating analog output.

Code Description
These are the point codes representing specific analog outputs that may be assigned 
to individual SCADA point numbers. Setting a code-description to the end descriptor 
defines the end of the configured points list and the maximum number of analog outputs 
that can be returned.

Figure 25. The Setup>Point Mapping>Counters screen.

The screen shown in Figure 25 contains configuration parameters for counter points. 
Map these points to make them available in the SCADA system.

DNP Counter Points
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Counter Point
This is the point number the SCADA system will use in response to a static or event data 
request or an unsolicited event response.

Code-Description
This is the point codes representing specific counter points that may be assigned to indi-
vidual SCADA point numbers. Setting a code-description to the end descriptor defines 
the end of the configured points list and the maximum number of counter points that 
can be returned. All counter points that can be mapped to individual SCADA points are 
also displayed on the Logs/Special Events screen.

Evt Class
This is the DNP event class in which this point can be placed. Specify Class 1, Class 2, 
or Class 3, or choose the No Event option to turn off event data reporting for this point.

Pct DeadBand
This is the deadband range expressed as a percentage of the previously reported counter 
point data. If the counter point data associated with this point exceed the range in either 
a positive or negative direction, the information will be included in the next event report. 
Choose the N/A option to turn off deadband reporting as a percentage of the previously 
reported counter point data.

Fixed Deadband
This is the deadband range expressed as a fixed value relative to the previously reported 
counter point data. If the counter point data associated with this point exceed the range in 
either a positive or negative direction, the information will be included in the next event 
report. Choose the N/A option to turn off deadband reporting as a fixed value relative to 
the previously reported counter point data.
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Figure 26. The Setup>Restoration>IntelliTeam SG>Team Summary screen.

DNP Addresses and Team Status

Team Selection
The tabs for Team 1 through Team 8 can be used to navigate to screens where general 
team parameters and information for individual team members are entered for  
IntelliTeam® II Compatibility Mode setting configuration. For the IntelliTeam SG 
system, the parameters in these screens are automatically entered by the netlist the 
IntelliTeam Designer software generated.

Auto-Clear Manual Operation
Select the Yes option to automatically clear the Manual Operation condition when all 
other Ready conditions are met for this team member. When “No” is selected, Manual 
Operation conditions must be cleared by an IntelliLink software or SCADA command 
before teams will return to the Ready state. The No setting is the default.

Time to Clear Manual Operation
When the Auto Clear Manual Operation setting is set to “Yes,” enter the time delay 
before the IntelliTeam SG system will clear the Manual Operation condition. (Range: 
1-1440 minutes; Step: 1 minute; Default: 1 minute)

The screen shown in Figure 26 shows the DNP/RTU address of the teams in which this 
control is a member and shows ready status for each team.

Team Addresses
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Switch State for Auto-Clear Manual Op
Select the switch state the switch must be in to automatically clear a Manual Operation 
condition when the Auto-Clear Manual Operation setting is enabled and the Time to 
Clear Manual Operation setting has been met. The three options are:

Normal—(Default) Auto-clear manual operations only on devices in their normal switch 
state.

Abnormal—Auto-clear manual operations only on devices in their abnormal switch state.

Both—Auto-clear manual operations on devices in their normal or abnormal switch state.

 WARNING
Selecting the Abnormal or Both setting will clear manual operation on a switch 
when it is in an Abnormal state . To ensure any associated team is not reenergized 
during maintenance activities, disable the Auto Clear Manual Operation function 
on the device and/or put the device in a Prohibit Restoration state .

Disregard First Overcurrent
When the Yes option is selected, the IntelliTeam application disregards the fault flag gener-
ated after the first overcurrent event is detected on the circuit and does not count it as a 
fault. Instead, it waits until after the first reclose/PulseClosing® Technology sequence to 
allow the distributed generation (DG) to be taken offline before counting the fault event. 
This will produce more accurate fault location information and lead to better load restora-
tion decisions when there is distributed generation feeding fault current into the circuit.

Note: Enabling this setting has no effect on the sectionalizing logic of the device (i.e. 
the Recloser Counts to Sectionalizer Trip setting is not impacted). This setting only 
impacts how the IntelliTeam system logic determines fault location.

When the No option is selected, the IntelliTeam system functions normally. The appli-
cation will qualify a fault condition and determine fault location based on the external 
device DNP status point information.

Not All Teams Transfer Ready for X Seconds Timer
This is the amount of time the device can go without seeing a coach from its adjacent 
team members before the Not all Teams Transfer Ready status point becomes active. 
The timer resets and the status point becomes inactive when a new valid coach arrives. 
(Range: 1-300 seconds; Default: Disabled)
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Figure 27. The Setup>Restoration>IntelliTeam SG>Team 1 through Team 8 screen.

Note: For any one team the values must be identical in all team members except for the 
Comm Port to Use setting.

Each team screen includes the following fields:

Team ID
Enter the name of this team, 16 characters maximum. This name will help identify the 
team to the SCADA operator. It appears on all reports generated from the team members. 
When saving a team configuration, this name is saved along with the other information. 
It also appears on the front panel display, if applicable.

Team Logic
This setpoint enables or disables IntelliTeam II software or sets various IntelliTeam SG 
system feature options for this team.

The Setup>Restoration>IntelliTeam SG>Team x screens help set the IntelliTeam II 
Automatic Restoration System parameters for each team in which this control is a member. 
Only use these screens when configuring this control to operate in the IntelliTeam II  
Compatibility Mode setting.

If this control is configured to operate in an IntelliTeam SG system, use IntelliTeam® 
Designer software. See S&C Instruction Sheet 1044-570, “IntelliTeam® Designer: User’s 
Guide.”

The Set Team setpoint is used with both IntelliTeam II and IntelliTeam SG software 
when it is necessary to restart the IntelliTeam system logic for troubleshooting purposes. 
See Figure 27.

Team Setup
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Set Team
This setpoint changes the operation status of the team defined on this screen. When team 
logic detects any parameter changes on this screen, the setpoint automatically changes 
to Stopped mode.

Note: When this value  is set to the Stopped mode and then back to the  
Running mode, IntelliLink software uses the setpoint values on this screen as the 
presently valid team parameters. Until all team members have identical values on this 
screen, the team will not be in the Ready state. 

Alternate Source Sequence
The way team members restore a line segment can be prioritized. If the team cannot use 
the source device (see the “Normal Sw Func” section on page 72) to restore the line 
segment, the team will try the members listed here, in the order configured.

The alternate source sequence is optional and does not need to be configured for 
automatic load restoration to occur. If this information was not entered or if the selected 
team members cannot be used to restore the line segment, the team will try to restore the 
line segment with the tie device(es). If this is not successful, the team will try to restore 
the line segment using the load/tie device(es).

General Team Parameters
These set points apply to the entire team.

Line Segment Limit
Configure this to the maximum number of line segments the team can pick up. For 
example, the Add 1 setting inhibits additional line segments from being restored through 
a member after the team restores one line segment. To allow the team to pick up as many 
line segments as capacity allows, set this value to “N/A.”

Contracts will be used if the Line Segment Limit threshold is set. Configuring this 
setpoint to a value other than “N/A” automatically changes the Contract Required 
setpoint to “Yes.”

Contract Required
If there is concern that a line segment may overload, set this value to a Yes setting. As 
team members encounter such line segments in a restoration path, they will communi-
cate with all the other line segments in the direction of the alternate source to ensure 
the alternate source will not be overloaded. 

Team Load Priority
This is user configurable and the default is the NoXfer setting. The choices are:

• Priority1_NoXfer—Load shedding or transferring is not allowed.

• Priority2_CloseXfer— <FUTURE> Load shedding is not allowed. Load transfer is 
allowed through closed transition only.
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• Priority3_OpenXfer—Load shedding is not allowed. Load transfer allowed through 
an open transition only.

• Priority4_XferShed—Load shedding is allowed. Only shed after transfers to other 
circuits have been considered.

Note: Priority 4 is the highest priority of this category.

• Priority5_XferShed—Load shedding is allowed. Only shed after transfers to other 
circuits have been considered.

• Priority6_XferShed—Load shedding is allowed. Only shed after transfers to other 
circuits have been considered.

• Priority7_XferShed—Load shedding is allowed. Only shed after transfers to other 
circuits have been considered.

Note: Priority 7 is the lowest priority of this category and will be transferred or shed 
before Priority 6, 5, 4, etc.

• Priority8_Shed—Load shedding is allowed. Shed these loads before considering 
load transfers to other circuits.

Note: Priority 8 is the highest priority of this category.

• Priority9-19_Shed—Load shedding is allowed. Shed these loads before considering 
load transfers to other circuits.

• Priority20_ShedNoXfer—Load shedding is allowed. Shed load will not be restored 
from an alternate circuit. Priority 20 is the highest priority of this category.

• Priority21_ShedNoXfer—Load shedding is allowed. Shed load will not be restored 
from an alternate circuit.

• Priority22_ShedNoXfer—Load shedding is allowed. Shed load will not be restored 
from an alternate circuit.

• Priority23_ShedNoXfer—Load shedding is allowed. Shed load will not be restored 
from an alternate circuit.

• Priority24_ShedNoXfer—Load shedding is allowed. Shed load will not be restored 
from an alternate circuit.

• Priority25_ShedNoXfer—Load shedding is allowed. Shed load will not be restored 
from an alternate circuit. Priority 25 is the lowest priority of this category and will 
be shed before any others.

Note: Any load configured with a priority of 20-25 will be shed and will not be restored 
until the circuit returns to normal. These will only be used when there is a self-tie in 
the circuit and will only be used on loads that are in the self-tie area. See Figure 28 on 
page 71.

Note: Using a load priority of 20-25 in a non-self-tie circuit will result in those teams not 
getting restored. To correct a misconfiguration, the load priorities must be configured 
with a different load priority (1-19) and the circuit must be re-pushed to the devices.

Note: If loads that were shed using Post Restoration Load Management (PRLM) are 
brought back online manually and the circuit has not been returned to normal, then the 
loads may be restored in subsequent events and will not be shed again. This is a known 
limitation of the PRLM logic. To shed these loads again, they must be shed manually.
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Return to Normal Time
This setting is the amount of time, in minutes, power must be restored to the faulted 
line segment before the Return to Normal process will start. (Range: 1 to 254 minutes;  
Default: 5)

Prohibit Restoration Time
Set this value for the amount of time (in minutes) the team is allowed to restore service 
after an event begins. If the team cannot restore service within this period, it will enter 
the Prohibit Restoration state, preventing any further restoration activity. It will 
remain in this state until cleared through the appropriate SCADA command or clicking 
on the IntelliTeam SG Restoration Enabled button on the IntelliTeam SG>Team 
Summary screen. For 6800 Series Controls and 6801M Switch Operators, the Automatic  
Restoration Enabled command on the faceplate or Operation screen can also be used.

Note: The Prohibit Restoration state must be cleared from a device being removed 
from an IntelliTeam system before pushing a new Netlist to avoid issues.

Team Member Settings  
These setpoints apply to individual team members in this team.

DNP/RTU Address
Enter the DNP/RTU address for each team member. One of these addresses must be the 
DNP/RTU address entered on the Setup>Communications>DNP screen.

Figure 28. Self-tie example diagram.
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Comm Port to Use
This column shows the port through which this team member is found for the purpose of 
peer-to-peer communications, either serial or Ethernet. If a single radio is used for peer-
to-peer communications, set this parameter to the port to which the radio is connected. 
Because the radio communication port may be different for each team member, this is the 
only parameter on this screen that can be different for each member of the same team.

When the Discover option is selected, the control will scan all ports, and the 
port that receives a response from a destination peer will be selected for subsequent 
communications.

Note: This parameter is not saved in a team setpoint profile and must be modified 
separately if the default value (Port B) is not correct. 

Sw/Pos Number
Position number associated with the team member, for example set Sw1 for a single 
overhead switch.

Normal Open/Close
The Normal Open or Normal Closed state of each device when the circuit is configured 
normally. The team uses this information during transfer operations.

Normal Sw Func
The IntelliTeam SG system dynamically assigns the switch functions for a team operating 
in the Closed Loop Operation mode. This is a team that has only two substation sources 
capable of supplying fault current, the same operation as the original IntelliTeam system.

If the listed control is part of a closed loop team, the field will have an asterisk “*” in 
the upper right corner. The IntelliTeam Designer software assigns a switch function at 
the time of configuration, but the IntelliTeam SG system may override that assignment. 
The assigned switch function is displayed when the screen updates.
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Select the normal switch function of each team member from the following settings. 
See Table 3.

Table 3. Normal Switch Function of Each Team Member

For normally closed IntelliRupter fault interrupters, 6800 controls, switches, 
breakers, and reclosers:

Function Characteristics

Source/Sub Assigned to the source device when it is the first team out of the substation or 
it is an IntelliNode Interface Module on a substation breaker

Source Assigned to the normally closed device that provides power to the line 
segment when the team is in its normal configuration

Load/Tie A team may have from zero to seven closed switches through which loads 
on other line segments receive power . This value is assigned when the 
switch could be involved in restoring power to the line segment because line 
segments on the other side of the switch have alternate sources .

Load A team may have from zero to seven closed switches through which loads on 
other line segments receive power . This value is assigned when the switch 
could not be involved in restoring power to the line segment because line 
segments on the other side of the switch have no alternate sources .

For normally open IntelliRupter fault interrupters, 6800 controls, switches, 
breakers, and reclosers:

Function Characteristics

Tie/Sub This is assigned when the tie switch is the first team member after the 
substation source . A tie/sub switch or recloser should have its voltage sensors 
facing the alternate source .

Tie This is assigned to open switches in the team that restores power to the line 
segment directly from an alternate source when closed . A team may have from 
zero to seven open switches .

Note: Every closed switch or recloser should have its sensors facing the normal source of the team . A 
tie/sub switch or recloser should have its voltage sensors facing the alternate source .

For IntelliNode Interface Modules directly associated with distributed 
generation sources:

Function Characteristics

Info Only This value is assigned when the IntelliNode Interface Module is directly 
associated to a distributed generation device to gather distributed generation 
real-time contribution data and status from the device and to send a Transfer 
Trip command to the distributed generation when necessary .

An info-only team member takes part in all normal team activity but cannot 
initiate a team transfer event, nor can it be selected as a switch to open or 
close during normal restoration and reconfiguration .

If DG Reconnect mode is enabled, and after the DG Reconnect Delay 
Timer Time setpoint expires, this IntelliNode module will also issue a Close 
command to the associated device to bring the distributed generation back 
online .
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Figure 29. The Setup>Restoration>IntelliTeam SG>External Loading screen.

Maximum Source Capacity 
This is the maximum feeder capacity (in amperes) as viewed from the substation end of 
the feeder. This value represents the maximum three-phase average load the feeder can 
carry at any time. (Range: 10-2,540 amps, Step: 10, Default: Disabled)

The screen shown in Figure 29 is used with feeder loading monitored at the substation 
breaker to calculate the real-time excess capacity available when a transfer occurs. Both 
Maximum Source Capacity and Default Source Segment Loading settings must 
only be set for SRC/Sub or Tie/Sub.

External Source 
Loading Setup

Rtn to Norm Mode
Team members can return the circuit to its normal configuration automatically when 
stable three-phase voltage has been restored to a faulted line segment or on command.

For teams with one or more tie switches, select the Open transition setting, and the 
tie device(es) open before other team members return the circuit to its normal configu-
ration. Select the Closed transition setting, and team members close the normal source 
switches and then the tie device(es) open. The Return to Normal process starts at the 
line segments closest to the normal source and works outward.

Maximum Capacity
Maximum load (in amperes) this team member can carry because of limitations such as 
conductor size and device rating, when carrying current in any direction.
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Overload Permitted 
This value is added to the Maximum Source Capacity threshold and becomes the new 
maximum load threshold that when exceeded requires immediate load shedding using 
the Post Restoration Load Management feature. This setting is only applicable when 
the IntelliTeam system Post Restoration Load Management options are enabled. 
Overloads above this level trigger a load-shedding event with no intentional delay to get 
the load under the Overload Permitted threshold, and the Time Overload Permitted 
timer will continue to count if it has not expired at this point.

The load will be shed based on the Team Load Priority setting configured for the 
affected team. Otherwise, when load is above the Maximum Source Capacity value 
but lower than the Overload Permitted threshold, it will be allowed to remain until the 
Time Overload Permitted timer expires, which triggers an immediate load-shedding 
event to get the load below the Maximum Source Capacity value.

At this point, the PRLM will identify the lowest priority team and shed its load. If 
shedding that team’s load does not eliminate the overload condition, the PRLM will find 
the next lowest priority team and shed its load. It will continue that process until the load 
falls below the Maximum Source Capacity value, removing the overload condition.

No other overload conditions will be allowed until the system returns to its Normal 
state. (Range: 0-2,550 amps, Step: 1, Default: 0) This setting is configured in the IntelliTeam 
Designer software and cannot be changed on this screen. See S&C Instruction Sheet 
1044-570, “IntelliTeam® Designer: User’s Guide.”

For example: If the Maximum Source Capacity value is set to 150 amps and the  
Overload Permitted value is set to 150 amps, the PRLM will allow up to 300 amps of 
load on that source before shedding load.

Time Overload Permitted
The total time load can be above the Maximum Source Capacity setting before load 
shedding is triggered. This setting is only applicable when the IntelliTeam system Post 
Restoration Load Management options are enabled. This setting is used along with 
the Overload Permitted setting to allow temporary overloads on a specific source. 
(Range: 0-7,200 minutes, Step: 1, Default: 0) This setting is configured in the IntelliTeam 
Designer software and cannot be changed on this screen. See S&C Instruction Sheet 
1044-570, “IntelliTeam® Designer: User’s Guide.”

Overload Qualification Time
This is the time the measured load must be above the Maximum Source Capacity 
setting to qualify as an overload condition. When an overload is qualified, the Time 
Overload Permitted timer begins timing. This setting is only applicable when the 
IntelliTeam system Post Restoration Load Management options are enabled. (Range: 
0-250 seconds, Step: 1, Default: 100)

For example: The Maximum Source Capacity setting = 400 amps, the Overload 
Permitted setting = 100 amps, the Time Overload Permitted setting = 5 minutes, 
and the Overload Qualification Time setting = 50 seconds. If the load goes above 400 
amps for 50 seconds, the Time Overload Permitted timer begins timing. If the load 
stays between 400 and 500 amps for 5 minutes, a load-shedding event is initiated based 
on the configured load priorities, and load will be shed to below the Maximum Source 
Capacity value.

S&C Instruction Sheet 1043-531  75

IntelliNode Interface Module Setup



Restore to Overload plus Max Capacity
When enabled, this setting allows IntelliTeam system to restore load up to the Maximum 
Source Capacity + Overload Permitted values during an IntelliTeam restoration event. 
This setting is only applicable when the IntelliTeam system Post Restoration Load 
Management Options function is enabled. (Default: Disabled)

This setting is configured in the IntelliTeam Designer software and cannot be changed 
on this screen. See S&C Instruction Sheet 1044-570, “IntelliTeam® Designer: User’s 
Guide.”

For example: The Maximum Source Capacity setting = 400 amps, the Overload 
Permitted setting = 100 amps, and the Restore to Overload plus Max Capacity setting 
= Enabled. When there is a restoration event, the IntelliTeam system will restore up to 
500 amps of load (the Max Source Capacity + Overload Permitted settings) for the 
configured source.

Default Source Segment Loading
The estimated peak three-phase average load (in amperes) of the source-side segment 
between the substation-feeder breaker and first IntelliRupter fault interrupter, 6800 
Switch Control, switch, or recloser. This value is used to estimate the maximum 
load in the event that real-time feeder loading data are not available or valid. (Range:  
0-2,540 amps, Step: 10.0, Default: Disabled)

Real-Time Feeder Loading Valid Timer
When real-time feeder loading data are received through SCADA, this configurable 
timer starts counting. If the loading data are not updated within the configured interval 
(in minutes), loading calculations will default to using the Default Source Segment 
Loading value. (Range: 1-60, Step: 1, Default: 20)

STATUS: Source Loading Data
If either the Maximum Source Capacity or the Default Source Segment Loading 
setpoint is not configured, the real-time loading feature is not active. This field will show 
“Disabled,” even if the team member receives feeder-loading data. In this case, the present 
calculations using the Maximum Source Capacity value are used. Both setpoints must 
be configured for this field to show “Enabled.”

STATUS: Real-Time Loading Data
This field will show “Invalid” if:

1. Either the Maximum Source Capacity or the Default Source Segment Loading 
setting is configured as Disabled.

2. Or the received real-time feeder loading data:

• Is zero

• Are less than the 3-phase average load of the IntelliRupter fault interrupter, 6800 
series switch control, switch, or recloser team member

• Are equal or greater than the Maximum Source Capacity setpoint

• Has not been updated within the Real-Time Feeder Loading Valid Timer setting

When this field shows “Invalid” the Default Source Segment Loading value will be 
used instead if it is configured.

Note: Real-time feeder loading data are only available at a sub switch.
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Figure 30. The Setup>Restoration>IntelliTeam SG>Communications screen.

Peer-to-Peer Message Retry Count 
This is the number of times the control resends a message to a team member that does 
not respond within the Peer-to-Peer Message Retry Time period. 

Note: Decreasing the Peer-to-Peer Message Retry Time value or increasing the 
Peer-to-Peer Message Retry Count setting may have a negative effect on some com-
munications systems because of increased traffic. Be sure to take this into account 
when changing these setpoints. (Range: 0-255, Step: 1, Default: 4)

Team Member Re-Qualify Time (minutes)
This is the number of minutes a team member will remain disqualified as a potential 
alternate source after that team member attempted but was unable to restore full service. 
This inability to restore full service is likely the result of a second contingency event, 
such as a loss of phase between the alternate source and the team member attempting to 
restore service. In this case, the team member would close, find that three-phase voltage 
is present, and reopen. (Range: 1-254, Step: 1, Default: 5

Peer-to-Peer Message Retry Time (sec) 
The control waits this amount of time (in seconds) to receive a response from another 
team member. If it does not receive the response within this time period, it resends 
the message to that team member. It continues sending the message until it receives a 
response or reaches the Peer-to-Peer Message Retry Count value. (Range: 0.000-65.535,  
Step: 0.001, Default: 6.000) See Figure 30.

Team Communication
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Netlist Verbose Logging
When enabled, all netlist-related event messages will be logged. The default is the  
Disabled setting because netlist logging quickly fills log memory and should only be 
used for troubleshooting a specific situation.

IntelliTeam Verbose Logging
When enabled, all IntelliTeam restoration system event messages (excluding Netlist-
related events) will be logged. The default is the Disabled setting because IntelliTeam 
system logging quickly fills log memory and should only be used for troubleshooting a 
specific situation.

Comm Check Runner Timeout
When this timer expires before the communications check runner cycle is complete, the 
Netlist push is incomplete. (Range: 30-500 seconds, Step: 1, Default: 120)

Data Runner Start Delay
This sets the interval between the completion of one data runner cycle (to collect and 
distribute real-time data) and the start of the next data runner cycle. (Range: 0-60,  
Step: 1, Default: 3)

Data Runner Timeout
When this timer expires before the data runner cycle is complete, a new data runner 
cycle is started. (Range: 20-120 seconds, Step: 1, Default: 30)

Request Timeout Delay
This sets the time interval between firmware upload completion and the subsequent 
request for a new Netlist. This delay also applies when a new control is deployed, it 
will wait this time interval before requesting a new Netlist. (Range: 1-65,535 seconds,  
Step: 1, Default: 40)

Report Periodic Delay
This sets the time interval between each Netlist transmission. (Range: 1-65,535 seconds, 
Step: 1, Default: 60)

DNP-IP Address Mapping
IP addresses can be mapped to DNP/RTU addresses for team members that are accessible 
only over an Ethernet port. An entry must be included in this table for any team member 
where Ethernet is the configured Comm Port to Use setting. The DNP Address value 
is the DNP/RTU address for the IP-based team members. The IP Address value is the 
IP address associated with the destination team members.
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Default DG Load Contribution 
This setting should only be used when no real-time loading data are available from a 
distributed generation (DG) device. (Range: 0–1000 A; Default: 0, meaning this is disabled 
and not used by the IntelliTeam system.)

When set to a Non-Zero value, the IntelliTeam system uses this as the amount of 
current flowing from the (DG) device into the distribution grid. When set to “Zero” 
(the default) and the DG device is teamed with an IntelliNode/Info-Only module, the 
IntelliTeam system uses loading polled by the IntelliNode/Info-Only module from the 
DG device as the current it’s contributing to the distribution grid.

However, if a normal IntelliTeam system device is teamed with the DG device, it 
will assume there are zero amps flowing into the distribution grid from the DG device 
when this value is set to “Zero.” The IntelliTeam system will then calculate the DG load 
contribution by using the direction and magnitude of current flow into or out of the 
IntelliTeam device.

Note: If this value is set to a Non-Zero value and the DG device is teamed with a 
normal IntelliTeam system device (i.e., not an IntelliNode/Info-Only module), the Intel-
liTeam system uses this value as the DG load contribution if the device teamed with the  
DG device measures less current than configured for the DG Load Contribution 
value.

For example, if the device measures 20 amps but the DG Load Contribution setting is 
80 amps, the IntelliTeam system will use 80 amps as the DG load contribution. Otherwise, 
if the device measures more current than configured for the DG Load Contribution 
setting, the IntelliTeam system will use the measured current from the device as the DG 
load contribution.

Note: The configured DG Load Contribution value will only appear on the device 
teamed with the distributed generation device in the Setup>Restoration>IntelliTeam 
SG>Distributed Generation screen. All other devices on the circuit will display 
“Disabled.”

Figure 31. The Setup>Restoration>IntelliTeam SG>Distributed Generation screen.

Distributed generation (DG) settings are used for IntelliTeam systems with distributed 
generation resources (e.g. solar, wind, etc.) on the circuit. See Figure 31.

Distributed Generation
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DG Reconnect Delay Timer Time
If set to a Zero value, then the DG Reconnect feature is disabled on all devices receiv-
ing a Transfer Trip message. Upon return of the normal source, users must manually 
close the device that opened due to the Transfer Trip command to bring the distributed 
generation back online.

Setting this to a Non-Zero value enables the DG Reconnect feature. After the 
normal source returns (either during restoration or the Return to Normal process) to 
the device that opened due to the Transfer Trip command, then the IntelliTeam logic 
will count down the timer. After the timer expires, the IntelliTeam system logic removes 
the Transfer Trip Prohibit Restoration (TTPR) mode on the device and will then 
close the device to bring the distributed generation device back online. (Range: 0-900 
seconds; Default = 0 seconds, meaning the Reconnect DG on Return to Normal mode 
is disabled.)

Note 1: The configured value will only appear on the device teamed with the distrib-
uted generation. All other devices on the circuit will display “Disabled.”

Note 2: If for any reason the DG Reconnect Delay Timer Time timer is aborted, 
the timer will not restart automatically and the distributed generation device must be 
manually put online.

Note 3: When an IntelliNode/Info-Only module is not directly associated with the 
distributed generation device, it is up to the distributed generation device’s own  
protection/control device (e.g. breaker, inverter, etc.) to reconnect the distributed  
generation device because the IntelliTeam system has no control over the device or the 
reconnection process. However, it should be put online when good voltage, current, and 
frequency are seen by the distributed generation protection/control device. 

When the IntelliTeam system control is an IntelliNode/Info-Only module directly 
associated with the distributed generation device, if it was sent the initial Transfer 
Trip command it will control the reconnection process and issue a Close command to 
the distributed generation device’s protection/control device when the DG Reconnect 
Delay Timer Time timer expires.

Disqualify DG Reconnect On Fault
If set to “Yes,” and the DG Reconnect Delay timer time is set to a non-zero value, the 
DG Reconnect feature will be disqualified if a fault was detected by the device that 
received the Transfer Trip command, but that device is not providing fault direction. If 
the DG Reconnect feature is disqualified, when the normal source returns, users must 
manually close the device that opened because of the Transfer Trip command to bring 
the distributed generation back online.

If set to “No,” and the DG Reconnect Delay timer is set to a Non-Zero value, the 
DG Reconnect feature will automatically close the device that opened because of the 
Transfer Trip command, bringing the distributed generation back online, even when 
that device detected a fault but does not provide fault direction.
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Figure 32. The Setup>Restoration>External Device screen.

Device
This is the Device ID for the remote device. This field is not configurable.

RTU Address
Enter the address of the remote device. (Range: 1-65519; Step: 1; Default: Not Configured)

Port Code
Select the port to use for transmitting to the remote device. (Default: UDP)

Remote Prohibit Restoration List Table (when using firmware  
version 7.3)
The screen shown in Figure 32 contains setpoints specifically related to sending the 
Prohibit Restoration SCADA command to remote devices. The non-zero RTU address 
in this list must be configured to receive a Latch On, Direct Operate SCADA control 
point when any of the following events are active in the control:

• Hot Line Tag mode is active

• A Frequency Trip state occurs

• The IntelliTeam SG system determines a Manual Operation event has occurred

• A SCADA Prohibit Restoration  command was received from a config-
ured master address and the Enable Remote Transmit from SCADA  
P. R. setpoint is enabled.

Prohibit Restoration is also sent when Prohibit Restoration mode is active in the 
local control, set from the front panel or with an IntelliLink screen command and the 
Enable Remote Transmit from Local P. R. setpoint is enabled.

Note: The Prohibit Restoration mode is applied to the device if a Frequency Trip 
event is active. Therefore, the Prohibit Restoration mode must be removed from the 
device to put it and the teams associated to it back into the Ready state.

Restoration—External 
Device
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IP Address
When the port code is set to “UDP,” enter the IP address of the remote device here.

Retry Count
Enter the number of retries to perform on any timeout event. (Range: 0-255; Step: 1; 
Default: 1)

Retry Timer
Enter the amount of time in seconds to wait before a retry is attempted. (Range: 0-255; 
Step: 1; Default: 5)

Control Point Number
Enter the DNP control point number that activates the Prohibit Restoration mode in 
the remote device. (Range: 0-255; Step: 1; Default: 0)

Commission Test
Selecting the Execute option from the drop-down menu sends a Prohibit Restoration 
command to the target device(s) to perform the operation in the exact same manner that 
will occur when the command is sent during normal operation.

NOTICE
Performing a Commission Test will apply the Prohibit Restoration state to the 
target device . The Prohibit Restoration state must be removed to put the device 
in the Ready state .

Test Result
This indicates “Pass,” “Pending,” “Bad Response,” or “No Result” for the sent Prohibit 
Restoration command. “Pass” means that the local device received an acknowledge-
ment from the remote device before the Retry Timer expired. “Pending” means that the 
local device sent out the test command but is still awaiting a response. “Bad Response” 
means that either the remote device rejected the command or the Retry Timer expired 
before the local device received an acknowledgement. “No Result” means that no tests 
have been performed yet.

Note: If DNP association of the peer device cannot be completed due to an incorrect 
RTU address, IP address, or Port Code, the Test Result field may show a Pending 
status indefinitely until the test is rerun again and the association can be made.

Enable Remote Transmit from Local P.R.
Enabling this option sends a Prohibit Restoration command to all devices in the list 
when the Prohibit Restoration state is activated locally via the front panel or IntelliLink 
screen.

Enable Remote Transmit from SCADA P.R.
Enabling this option will send a Prohibit Restoration command to all devices in the 
list if any the following events are active: Hot Line Tag mode, Frequency Trip state, 
Manual Operation state, or Prohibit Restoration state is activated from a SCADA 
command from a configured master station address.
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Remotely Clear Prohibit Restoration
Clicking on this button sends a Clear Prohibit Restoration command to the local 
device and all devices in the list and will clear the local Prohibit Restoration state. If 
an event is still active (Hot Line Tag mode, Frequency Trip state, Manual Operation 
state) the Clear Prohibit Restoration command will not be sent.

Remote Transfer Trip List Table (when using firmware version 7.3.x)
Transfer Trip commands are sent from the device to distributed generation (DG) 
resources within the distribution system immediately upon detection of a circuit anomaly 
so the DG does not interfere with IntelliTeam system restoration activities. This action 
is both for safety reasons and for the protection of load. See Figure 31 on page 79.

If the local device trips open due to a Protection or Automatic Sectionalizing event, 
and the Transfer Trip feature is enabled, Then, it sends Transfer Trip (TT) commands 
to all devices, whether S&C controls or third party controls, listed on its Remote Transfer 
Trip list. The TT commands are sent, no matter what state the DG/DER is in at the time, 
to ensure it is disconnected from the system. When the trip is due to a protection event 
the TT commands will initiate following the initial trip. Lockout state is not necessary.

Device
This is the Device ID for the remote device. This field is not configurable.

RTU Address
Enter the address of the remote device. (Range: 0-65519; Step: 1; Default: Not Configured) 

Port Code
Select the port to use for transmitting to the remote device. (Default: UDP)

IP Address
When the port code is set to “UDP,” enter the IP address of the remote device here.

Retry Count
Enter the number of retries to perform on any timeout event. (Range: 0-255; Step: 1; 
Default: 1)

Retry Timer
Enter the amount of time in seconds to wait before a retry is attempted. (Range: 0-255; 
Step: 1; Default: 5)

Control Point Number
Enter the DNP control point number that activates the Transfer Trip mode in the remote 
device. (Range: 0-255; Step: 1; Default: 0)
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Protocol
When the remote device is an S&C device select the peer-to-peer (P2P) protocol. The P2P 
protocol allows the remote S&C device to report the actual opening of the remote device 
to the sending device, to allow the IntelliTeam system to proceed with transfer events. 
When the remote device is not an S&C device, select DNP3 for the protocol.

DNP Control Type
Enter the appropriate control type for the configured Control PT Number setpoint: 
Pulse On, Latch On or Breaker Close. When received, the remote control will issue 
an Open command to the distributed generation switch.

Commission Test
Selecting “Execute” from the drop-down menu sends a Transfer Trip command to the 
target device(s) in the exact same manner that will occur when the command is sent 
during normal operation.

NOTICE
Performing a commission test will operate the target device by sending it an Open 
command . A Close command must be sent to the device and any alarms cleared 
to put the device in the Ready state .

Test Result
This indicates “Pass,” “Pending,” “Bad Response,” or “No Result” for the sent Prohibit  
Restoration command. “Pass” means that the local device received an acknowledge-
ment from the remote device before the Retry Timer expired. “Pending” means that the 
local device sent out the test command but is still awaiting a response. “Bad Response” 
means that either the remote device rejected the command or the Retry Timer expired 
before the local device received an acknowledgement. “No Result” means no tests have 
been performed yet.

Remote Transfer Trip
Selecting the Enabled state allows commands from this device to be sent to all non-zero 
RTU addresses listed on the Remote Transfer Trip list. Selecting the Disabled state 
blocks the commands. When there are no distributed generation resources listed on the 
Remote Transfer Trip list, set this to “Disabled.”

Control Relay Pulse On Time 
This sets the control relay output block on time for the distributed generation devices that 
receive DNP3 transfer trip control requests. Each count is 1 ms. (Range: 0-4,294,967,295; 
Step: 1; Default:1)

Control Relay Pulse Off Time 
This sets the control relay output block off time for the distributed generation devices that 
receive DNP3 transfer trip control requests. Each count is 1 ms. (Range: 0-4,294,967,295; 
Step: 1; Default: 0)
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Figure 33. The Setup>Restoration>External Device screen Remote Transmit List.

Remote Transmit List Table
With firmware versions 7.5.x and later, the Remote Prohibit Restoration List and 
Remote Transfer Trip List functionality has been combined into a single table called, 
“Remote Transmit List.” This table is on the Setup>Restoration>External Device screen 
and includes the same functionality for sending a Remote Prohibit Restoration or 
Remote Transfer Trip command to remote devices as was available in the 7.3.x firmware 
release. See Figure 33.

DEVICE
This is the Device ID of the remote device and is not configurable.

Function
Select “Xfer Trip” to send a Transfer Trip command to a remote device. Select  
“Proh. Rest.” to send a Prohibit Restoration command to a remote device. Default is 
“None,” which means no function is selected for the device.
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When “Proh. Rest.” is selected as the function, the device will send the Prohibit  
Restoration SCADA command to remote devices. The non-zero RTU address in this list 
must be configured to receive a Latch On, Direct Operate SCADA control point when any 
of the following events are active in the control: 

• Hot Line Tag mode is active

• A Frequency Trip state occurs

• The IntelliTeam SG system determines that a Manual Operation event has occurred 
or a SCADA Prohibit Restoration command was received from a configured master 
address

• The Enable Remote Transmit from SCADA P. R. setpoint is enabled

Prohibit Restoration is also sent when Prohibit Restoration mode is active in the 
local control, set from the front panel or with an IntelliLink screen command and the 
Enable Remote Transmit from Local P. R. setpoint is enabled.

When “Xfer Trip” is selected as the function, Transfer Trip commands are sent from 
the device to distributed generation (DG) resources within the distribution system imme-
diately upon detection of a circuit anomaly so the DG does not interfere with IntelliTeam 
restoration activities. This action is both for safety reasons and for the protection of load.

If the local device trips open because of a Protection or Automatic Sectionalizing  
event, and the Transfer Trip mode is enabled, then, it sends Transfer Trip (TT)  
commands to all devices, whether S&C controls or third party controls,listed on its  
Remote Transmit List that have “Xfer Trip” configured for their function. The TT  
commands are sent, no matter what state the DG/DER is in at the time, to ensure it is 
disconnected from the system. When the trip is because of a Protection event the TT 
commands will initiate following the initial trip. The Lockout state is not necessary.

RTU Address
Enter the DNP RTU address of the remote device. (Range: 0-65519; Step: 1; Default: Not 
Configured)

Port Code
Select the port to use for transmitting to the remote device. (Default: UDP)

IP Address
When the Port Code setting is ‘‘UDP,’’ enter the IP address of the remote device here.

Retry Count
Enter the number of retries to perform on any timeout event. (Range: 0-255; Step: 1; 
Default: 1)

Retry Timer
Enter the amount of time in seconds to wait before a retry is attempted. (Range: 0-255; 
Step: 1; Default: 5)

Control Point Number
Enter the DNP control point number that activates the Prohibit Restoration mode in 
the remote device. (Range: 0-255; Step: 1; Default: 0)
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DNP Control Type
Enter the appropriate DNP Control Type value for the configured Control Point 
Number setpoint: Pulse On, Latch On or Breaker Close. When received, the remote 
control will issue an Open command to the distributed generation switch.

Commission Test
Selecting the Execute command from the drop-down menu sends a Prohibit Restoration 
command to the target device(s) to perform the operation in the exact same manner the 
command is sent during a normal operation.

NOTICE
A Commission Test command will apply the Prohibit Restoration state to the 
target device . The Prohibit Restoration state must be removed to put the device 
in the Ready state .

Test Result
This indicates ‘‘Pass,’’ ‘‘Pending,’’ ‘‘Bad Response,’’ or ‘‘No Result’’ for the sent Commission 
Test command. ‘‘Pass’’ means the local device received an acknowledgement from the 
remote device before the Retry timer expired. ‘‘Pending’’ means that the local device 
sent the Commission Test command but is still waiting for a response. ‘‘Bad Response’’ 
means either the remote device rejected the message or the Retry timer expired before 
the local device received an acknowledgement. ‘‘No Result’’ means no tests have been 
performed yet.

Note: If DNP association of the peer device cannot be completed because of an incor-
rect RTU address, IP address, or Port Code, the Test Result field may show “Pending” 
indefinitely until the test is rerun again and the association can be made.

Enable Remote Transmit from Local P.R.
Enabling this option sends a Prohibit Restoration command to all devices in the list 
when the Prohibit Restoration state is activated locally via the front panel or IntelliLink 
software screen.

Enable Remote Transmit from SCADA P.R.
Enabling this option will send a Prohibit Restoration command to all devices in the 
list if any the following events are active: Hot Line Tag mode, Frequency Trip state, 
Manual Operation state, or Prohibit Restoration state is activated from a SCADA 
command from a configured master station address.
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Clear Prohibit Restoration on Hot Line Tag Removal
When both the Clear P.R. on Hot-Line-Tag Removal and the Enable Remote Transmit 
from SCADA PR settings are enabled, the Prohibit Restoration state will be cleared on 
a device when the Hot Line Tag state is removed from the device, provided a Frequency 
Trip state is not active. At that point, the device will also send a Clear PR SCADA 
command to all devices listed in its Remote Transmit List table that have the Prohibit 
Restoration function configured. A device receiving this Clear PR command will then 
clear its Prohibit Restoration states, other than those Prohibit Restoration states 
that were caused by a Transfer Trip event or a PRLM Do-Not-Restore Load Shed event.

Note: Receiving a propagated Prohibit Restoration Clear command will clear the 
Prohibit Restoration state even if any of the local critical conditions are still present, 
including Hot Line Tag, Frequency Trip, and Manual Operation. If these critical 
conditions are present, they will remain active on the local device, and the local device 
and its associated team members will remain in the Out of Ready state, until the criti-
cal conditions are cleared themselves.

Note: The Clear P.R. on Hot-Line-Tag Removal setting is hidden until the Enable 
Remote Transmit from SCADA PR setting is set to “Enabled.”

Remotely Clear Prohibit Restoration
Clicking on this button sends a Clear Prohibit Restoration command to the local 
device and all devices in the list and will clear the local Prohibit Restoration state. If 
an event is still active (Hot Line Tag mode, Frequency Trip state, Manual Operation 
state) the Clear Prohibit Restoration command will not be sent.
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Figure 34. The Logs>Log Management screen.

Logging Settings

Logging Level
The logging level selected determines the type of data-log messages captured in the 
base memory module (for an IntelliRupter fault interrupter) and is displayed on the 
Logs>Historic Log screen. Every data-log message is assigned a specific log level:

Normal—User information

Extended—User information and internal status

All—User information, internal status, and internal trace/debugging information

Duplicate Event Margin (milliseconds)
Storing identical events in a short time period can flood internal memory and does not 
provide useful diagnostic information. By configuring the time between duplicate-event 
log entries, this set point determines which data will be stored in the internal memory 
and be displayed on the Logs>Historic Log screen. It has no effect on an alternating 
sequence of events.

Two events are considered duplicates when every element of their event 
records match. For example, when the Duplicate Event Margin setting is  
10 ms. and the sequence of events ABABAB (where A and B are different) has every event 
occur 1 ms after the previous one. The identical events occur within 2 ms, well within 
the value of the set point, but all events will be logged because events are alternating. 
(Range = 0-30, increment = 1.)

The screen shown in Figure 34 configures the filter settings for viewing log screens. The 
administrative login is required to execute any of the log-control functions.

Log Management
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Stop Historic Logging if Full
When enabled, this setting stops logging events when the Historic log is full and subse-
quent events are discarded without overwriting contents of the log. Flash memory logging, 
the Status Point log, and Special Events counter logging are not affected by this set 
point. Do not set this to “Yes” unless doing troubleshooting. When troubleshooting is com-
pleted or new event data are desired, set this to “No” to ensure continued event logging.

Compact Flash Logging
When enabled, every historic event generated is written to flash memory. Logging Level 
and Duplicate Event Margin setpoints do not prevent an event from being written to 
flash memory. Flash memory logging preserves as much data as possible. Flash memory 
data can be retrieved with IntelliLink software. Open the Tools option on the menu bar 
and click on the Compact Flash Access option. Select and save any files needed. S&C 
strongly recommends enabling the Compact Flash Logging setting to simplify diag-
nostic and troubleshooting work.

Event Categories
Select the categories that will be displayed on the Logs>Historic Log screen. To display 
only the most important operation information, select the EVT category and click the 
Refresh View button. Utility operation data will be displayed and log information for 
software troubleshooting and debugging will be omitted.

Logging Control
Complete data are stored in the Historic Event log in flash memory. Flash memory files 
can be downloaded by opening the File option on the menu bar and clicking on the Flash 
Memory Files option. The complete Historic Event log (up to a million events) cannot 
be viewed through IntelliLink software, but a small subset of the Historic Event log (160 
events) is displayed on the Logs>Historic Log screen. Event filters can be applied to the 
Logs>Historic Log screen, but these filters do not affect entry of events in the Historic 
Event Log. 

Clear View
This button clears all data on the Logs>Historic Log screen. In Real-Time View mode, 
the next qualifying event will be placed at the top of the Logs>Historic Log screen. In 
Static View mode, the Logs>Historic Log screen will remain empty until it is completely 
refilled.

Refresh View
This button clears the present contents of the Logs>Historic Log screen and loads up 160 
events from the Historic Event log in ascending chronological order. Only events satisfying 
the checked Event Categories options are displayed on the Logs>Historic Log screen.

Real Time View or Static View
Use this drop-down menu to select the view mode. Real Time View mode loads the latest 
data on the screen, and Static View mode freezes data on the Logs>Historic Log screen.
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Historic Logging
Running—Starts the Historic log but does not affect flash memory logging, Status Point 
log entries, or Special Events logging.

Stopped—Stops the Historic log but does not affect flash memory logging, Status Point 
log entries, or Special Events logging. Subsequent events will not be put into the Historic 
log, preventing newer events from overwriting older events. Be sure to return the Historic 
Logging mode to “Running” so future events will be logged.

Clear History Log
This button clears all data in the Historic log. It does not affect flash memory logging, 
Status Point log entries, or Special Events logging. The date and time of the last Clear 
History Log command are displayed. Clearing the Historic log permanently deletes all 
event data. If wanting to preserve event data, generate an HTML report of logged data 
before clearing the log.

Chronological Browsing (static – no refill)
Chronological browsing is only available in the Static View mode. It is not available in 
the Real Time View mode. Because the size of the Logs>Historic Log screen is only 
a fraction of that of the Historic Event log, the Historic Event log must be navigated 
chronologically, either by Browse By Time mode or Browse By Page mode.

Browse By Time
This loads up to 160 events that occurred at or after the specific time entered. Only 
events that satisfy the event categories criterion are placed in the Logs>Historic Log 
screen. If all events in the Historic Event log occurred before the specified time, the 
oldest-available events are placed in the Logs>Historic Log screen. The Logs>Historic 
Log screen is refilled as soon as the specific time is entered; the specified time is cleared 
when the refill is complete.

Browse By Page
Historic log pages can be browsed four ways:

Oldest 8 Pages—Loads up to 160 of the oldest-qualifying events from the Historic 
Event log.

Newest 8 Pages—Loads up to 160 of the newest-qualifying events from the Historic 
Event log.

Previous 8 Pages—Loads up to 160 previous events relative to the events currently in 
the Logs>Historic Log screen.

Next 8 Pages—Loads up to 160 next events relative to the events currently in the 
Logs>Historic Log screen.

When the selection is entered, the Logs>Historic Log screen is refilled immediately. 
Because the Historic Event log is circular, selecting the Previous 8 Pages option may 
cause the newest events to be displayed (if the Logs>Historic Log screen presently holds 
the oldest). Similarly, selecting the Next 8 Pages option may cause the oldest events to 
be displayed (if the Logs>Historic Log screen presently holds the newest).
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Password 
Management

Admin User Default Password Change
With software later than version 7.3.100, a user is required to change the default user 
passwords in the IntelliLink Setup Software before it will allow the user to access the 
control and read or modify settings on the control using IntelliLink software. This is 
required for all user accounts, including the Admin account, which must be changed first 
before any user can access a control. See Figure 35.

Non-Admin User Default Password Change
When users attempt to log in with one of the non-admin accounts before the default 
password is changed, they will be notified via the following message that the Admin 
user must change the default user account password before being allowed to connect to 
a control. See Figure 36.

Figure 35. The Password Change Required dialog box requesting the user change the 
password to a non-default password.

Figure 36. The Password Change Required dialog box requesting the user update the 
password to the proper complexity.
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Change Admin User Password
With software later than version 7.3.100, the Admin user account default password must 
be changed before IntelliLink software can connect to a control.

Follow these steps to change the Admin user password:

STEP  1.  After IntelliLink Setup Software is launched and the default Admin password 
is used to connect to a control, the prompt shown in Figure 37 opens to instruct 
the user to change the Admin user account password.

Figure 37. The Password Change Required dialog box.

Password Complexity Rules
When changing a user password using IntelliLink software, complexity rules are enforced 
for the new password. See Table 4.

Table 4. Password Complexity Rules
Rule Description

Password Length Must be between 8-12 characters long

Alpha Characters Must have at least one uppercase and one 
lowercase character

Special Characters
May contain special characters with the exception 
of the “Space,” “Tab,” and “&,” characters, which 
are not allowed

Numbers May contain numbers

When the password entered does not meet the complexity requirements, the error 
message shown in Figure 36 on page 92 will open and the Admin user will be required to  
enter a password that meets the complexity requirements before being allowed to proceed.
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STEP  2.  Enter a new non-default password that meets the complexity requirements into 
the Enter Password and Confirm Password fields. Then, click on the  
OK button. See Figure 38.

Figure 38. The Change Password dialog box.

STEP  3.  When the password is changed successfully, the Successfully Changed dialog 
box opens. See Figure 39. Click on the OK button to finish the change-password 
process. If the password was not changed successfully, go to Step 4.

Figure 39. The Password Change Required dialog box displaying a successful 
password change message.
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STEP  4.  When the password was not successfully changed, the Password Change 
Required dialog box opens. See Figure 40. Click on the Yes button to change 
the password again and go back to Step 2 on page 94.

Figure 40. The Password Change Required dialog box.

Change Non-Admin User Password
With software  later than version 7.3.100, the Non-Admin user accounts (i.e. Engineer1/2, 
Technician1/2/3, Operator, and Viewer) must have the passwords changed by an Admin 
user before a control can be connected using IntelliLink software.

Note: The Admin password must have been changed to a non-default password before 
a Non-Admin user can access a control. If this has not been done, go to the “Admin User 
Default Password Change” section on page 92 for instructions on how to change the 
Admin password before proceeding with the next instructions.

Follow these steps to change a Non-Admin user password:

STEP  1.  Launch the IntelliLink Setup Software and log in using the Admin account and 
the non-default Admin password.

S&C Instruction Sheet 1043-531  95

Security



Figure 41. The Setup>Security screen.

STEP  2.  Go to the Setup>Security screen in IntelliLink Setup Software. See  
Figure 41.
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STEP  3.  Click on the Password field for a given user and enter a new non-default 
password that meets the complexity requirements into the Enter Password 
and Confirm Password fields. Then, click the OK button. See Figure 42.

Figure 42. The Change Password dialog box.

STEP  4.  When the password has been entered, click on the Validate button in the top 
right corner of the IntelliLink screen. See Figure 43.

Figure 43. The Validate button.

STEP  5.  If the password change validates successfully, click on the Apply button to 
finish the password-change process and configure the new password on the 
control. See Figure 43. Go to Step 6 if the password change was not validated 
successfully.

STEP  6.  If the password was not successfully validated, the Validation Error dialog box 
will open. See Figure 44 on page 98. Click on the OK button to attempt to 
change the password again. Go to Step 3.
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Figure 44. The Validation Error dialog box.

Only a user logged in as Admin (administrator) can make changes to this screen.  
See Figure 45. The user group name can be changed for all groups except Admin and 
Viewer. All passwords can be changed, and all default passwords must be changed by 
the Admin at initial login.

Security Screen

Figure 45. The Setup>Security screen.

The following security controls are available for selection by the Admin for the various 
user groups:

• General–When checked, it allows the user group to configure all configurable settings 
found on the Setup>General screen.

• Protection–When checked, it allows the user group to configure all configurable 
settings found on the Setup>Protection screen.

98  S&C Instruction Sheet 1043-531

Security



IntelliLink Remote Commands
When set to Enabled mode, IntelliLink Setup Software can be used to access the device 
operation commands. The Disabled setting is the default.

For all device types, these commands are not available when this setting is set to 
Disabled mode:

• IntelliTeam SG Restoration—on the IntelliTeam SG>Team Summary screen

• Clear Manual Operation—on the IntelliTeam SG>Team Summary screen

For IntelliNode Interface Modules, these commands are not available when this setting 
is set to Disabled mode:

• Device Data Updates—on the Setup>External Device>Start screen

• Control Test—on the Setup>External Device>DNP Control Point Map screen

• Communication–When checked, it allows the user group to configure all configurable 
settings found on the Setup>Communication screen.

• Restoration–When checked, it allows the user group to configure all configurable 
settings found on the Setup>Restoration screen.

• Operation–When checked, it allows the user group to configure all configurable set-
tings found on the Operation screen.

• Update Firmware–When checked, it allows the user group to perform a firmware 
upgrade on the control using the Tools>Firmware Update option on the Tools menu.

Note: When the Update Firmware option is checked, all other settings groups (Pro-
tection, Communication etc.) become enabled for the user that has been allowed to 
update firmware by the Admin. If the Admin disables access to any settings group 
after the Update Firmware option is checked and settings are validated, the disabled 
setting is automatically re-enabled. As long as Update Firmware option is enabled, 
all settings groups will be enabled automatically when the settings Apply command 
is initiated.

Changes will not take effect until the Apply command is selected on the Setup>Validate/
Apply screen..
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Validate
The Validate button evaluates settings in the buffer memory without applying them. 
When changes are pending, click on the Validate button to initiate a logical check of the 
pending changes for errors. If the validation procedure detects an error or inconsistency, 
it will be displayed in the Validation Result box.

Apply
The Apply button evaluates settings in the buffer memory and applies them. When 
changes are pending, click on the Apply button to initiate a logical check of the pending 
changes for errors and commit the changes to control memory if no errors are detected. 
A successful check will be indicated in the Validation Result box.

Reset Buffer
The Reset Buffer button resets settings in the buffer memory to the presently active 
values. It will not undo an Apply command. When changes are pending, click on the 
Reset button to remove pending changes and return to the setting presently located 
in the control memory. The Validate, Apply, and Reset icons will fade to indicate no 
changes are pending.

Figure 46. The Setup>Validate/Apply screen.

Settings are stored in the buffer memory of the control and are not active until they have 
been applied. The screen shown in Figure 46 provides commands for managing settings 
between the buffer memory and the active settings area of the control.
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Validation Results
If a Validation or Apply command is unsuccessful, the Validation Result field will 
provide information related to the violated validation rules.

Command Status
Shows the result of the last Validation or Apply request.
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Factory Reset Using 
IntelliShell NOTICE

Factory Reset functionality requires installing the default setpoints/setting file on 
the system for the firmware version the control is running at the time the factory 
reset is used . Therefore, to proceed with the factory reset, make sure the default 
setpoint/settings file is properly installed . If the default setpoints/settings file is not 
installed, the factory reset procedure will not be executed .

STEP  1.  Click on the IntelliShell button and click on the Local Connection (Serial/
Wi-Fi) button. See Figure 47.

Figure 47. The IntelliShell Local Connection button.

STEP  2.  Select the product on which to perform the factory reset and click on the Serial 
button. See Figure 48.

STEP  3.  Click on the Factory Reset option to launch the Factory Reset procedure. 
See Figure 49.

After clicking on the Factory Reset option, the IntelliLink software will 
launch and the user must login using the admin account.

Figure 48. The Product Selection and Serial connection option.

Figure 49. The Factory Reset button.
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STEP  4.  When prompted, enter “admin” for the username and enter the admin password 
in the password field. See Figure 50.

Figure 50. The IntelliLink Login dialog box.
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STEP  5.  Click on the Proceed to Factory Reset button when prompted. See Figure 51.

Figure 51. The Proceed to Factory Reset button.

NOTICE
Performing a Factory Reset procedure on software versions 7 .5 and earlier results 
in usernames, passwords, and other security settings being reset to default-setting 
values . The communication settings are not set to default values as part of this 
procedure to allow the IntelliLink software to reconnect to the control when the 
factory reset is completed .

Performing a Factory Reset procedure on software versions 7 .6 and later results in 
all settings (including usernames, passwords, security, and network settings) being 
reset to default-setting values . Because the network settings are reset to factory 
defaults, default network settings must be used to reconnect to the control when the 
factory reset is completed .  

STEP  6.  When the Factory Reset procedure is completed, click on the Cancel button 
to complete the procedure. See Figure 52.

Figure 52. The Factory Reset completed successfully message.

NOTICE
When the factory reset is completed, the admin password will revert to the default 
password . At the initial login, the admin user will be required to change the password 
to a non-default password that meets the complexity requirements .
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Factory Reset Using 
IntelliLink

STEP  1.  Login to the IntelliLink software application using the admin username and 
password.

STEP  2.  Click on the Tools>Device Maintenance button. See Figure 53.

Figure 53. The Tools>Device Maintenance button.
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STEP  3.  When the Device Maintenance window opens, click on the Factory Reset 
button to launch the Factory Reset procedure. See Figure 54.

Figure 54. The Factory Reset button.

STEP  4.  Click on the Proceed to Factory Reset button when prompted. See Figure 55.

NOTICE
Performing a Factory Reset procedure on software versions 7 .5 and earlier results 
in usernames, passwords, and other security settings being reset to default-setting 
values . The communication settings are not set to default values as part of this 
procedure to allow the IntelliLink software to reconnect to the control when the 
factory reset is completed .

Performing a Factory Reset procedure on software versions 7 .6 and later results in 
all settings (including usernames, passwords, security, and network settings) being 
reset to default-setting values . Because the network settings are reset to factory 
defaults, default network settings must be used to reconnect to the control when the 
factory reset is completed .  

Figure 55. The Proceed to Factory Reset button.
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STEP  5.  When the Factory Reset procedure is completed, click on the Cancel button 
to complete the procedure. See Figure 56.

Figure 56. The Factory Reset completed successfully message.

NOTICE
When the Factory Reset procedure is completed, the admin password will revert to 
the default password . At the initial login, the admin user will be required to change 
the password to a non-default password that meets the complexity requirements . 
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